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Abstract 
In this document, we provide step-by-step guidance to configure support for the SAFe V4.0 

methodology in CLM tooling. 
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CONFIGURING IBM 
COLLABORATIVE LIFECYCLE 
MANAGEMENT (CLM) FOR 
SAFE® 4.0 
 

DELTA UPDATES 
The purpose of this section is to summarize the set of fixes and enhancements made to the SAFe 4.0 

process templates since the initial release on 3-18-2016.  

Last Update Product Template Summary 

08-17-2016 RTC Portfolio, 
Program 

Added specifications for which work item types should be 
marked as “plan items” 

08-05-2016 RTC Portfolio, 
Program 

Support for "Definition of Done":  

 Add Checklist tab on Capability, Feature and Story 

 Includes new enumeration: Checklist Item Status 

 Includes new attributes: Acceptance Test, 
Performance Test, Documentation, UX Design, 
Checklist Notes 

 Includes updated editors 

 Add Pre-Defined Queries 

Merge Backlog and Roadmap Timelines for Value Stream, 
Program to enable a consolidated plan view representing 
the “Roadmap”  

Update OOTB plans based on timeline update, merge 
Backlog with Roadmap plans at Portfolio level 

Support for calculating and rolling up story points:  

 Actual Story Points (numeric) attribute on Epics, 
Capability and Feature 

 Story Points (numeric) attribute on Story – hidden, 
calculated from Story Points complexity attribute 

New work item templates 

Add Proposed attribute (Iteration) 

 Change WSJF to “decimal” type to allow for more precision 
in the calculation.  
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INTRODUCTION 
Complete end-to-end support for SAFe 3.0 was delivered in version 6.0.1 of the IBM Collaborative 

Lifecycle Management (CLM) solution , just prior to the announcement of Scaled Agile Framework® 4.0. 

Additional enhancements have been added to the SAFe V3.0 templates in CLM 6.0.2. This document 

describes how to configure CLM 6.0.1 (and later releases) to support SAFe 4.0, starting with the out-of-

the-box SAFe 3.0 templates available in CLM 6.0.2.  

 

SAFe 4.0 introduces an option to more robustly govern the delivery of Value Streams via a 4-level SAFe 

framework. Three-level SAFe is still available as well for smaller, less complex businesses. There are also 

additional artifacts at the Value Stream level (with 3- or 4-level SAFe) related to elaborating the Solution 

Intent and Solution Context. The changes to configure a SAFe 4.0 environment focus primarily on the 

capabilities that support the Value Stream layer, although there are other changes that impact Portfolio, 

Program and Team as well.  

Below you will find sections for configuring each of the SAFe V3.0 templates provided in Rational Team 

Concert (RTC), Rational DOORS Next Generation (RDNG) and Rational Quality Manager (RQM). You may 

want to configure all three environments or focus just on RTC. Note that some of the RTC and RQM 

template configurations must be made in the Eclipse client once you have extracted the updated 

process template.  

Portfolio Add Risk, Defect, and Retrospective work item types to 
Portfolio 

Program Add "How Found" attribute with pre-populated enum list 
to Defect work item type 

Fixed bug in Feature Workflow: Analyzing -> Ready for 
Approval 

RDNG Portfolio Change Allocated Investment and Bugeted Capacity 
attributes to be Float data type 

Create Program artifact in RDNG to capture 
budget/capacity for at a Program level. Create Program 
Template.  

Create new/updated views for use on RDNG dashboard for 
Programs and Value Streams 

Create stub Programs in Value Streams 

03-18-2016 CLM (All) Portfolio 
Program 

Initial beta release of templates 

Note: You should download CLM 6.0.2 M3 (Milestone 3) or later. You do not need to 

be running 6.0.2 in a production environment. This version is simply required so that 

you can get the 6.0.2 versions of the SAFe 3.0 templates, so a trial version is fine.   
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ASSUMPTIONS 
The steps in this document assume that:  

 You have a CLM 6.0.2 M3 (or later) environment installed with SAFe templates deployed.  

 You have Administrative authority and experience configuring process/project templates.  

RATIONAL TEAM CONCERT SAFE V4.0 CONFIGURATION 
Before configuring the SAFe V4.0 project areas, you need to create them based on the SAFe V3.0 

templates. You will create two RTC project areas: My SAFe V4.0 Portfolio and My SAFe V4.0 Program.  

1. Launch RTC’s Administration Page in your browser and log on as an Administrator.  

2. Navigate to the Templates page by selecting the Template option from the menu bar.  

3. Ensure you have the SAFe predefined templates deployed:  

 
 

If you do not see these, click the Deploy Predefined Templates link.    

4. Select Project Areas > Create > Project Area from the menu bar and create a new SAFe V4.0 Portfolio 

project area using the SAFe 3.0 Process (Portfolio) template:  

 

5. Add yourself (the Administrator user) as a member of the project with the Portfolio Manager role. 

6. Save your changes. 



Configuring SAFe V4.0 in CLM 7 8/17/2016 

7. In another browser tab, launch RTC’s Administration Page, log on as an Administrator and Select 

Project Areas > Create > Project Area.  

8. Create a second project area for the SAFe V4.0 Program based on the SAFe 3.0 Process (Program) 

template:  

 

9. Add yourself (the Administrator user) as a member of the project with the Product Manager role. 

10. Save your changes. Leave both project areas opened in your browser.  

Update the project area characteristics as described in the sections below for each of the project areas.  

SAFE V4.0 PORTFOLIO CONFIGURATIONS (BROWSER) 

TEAM AREA HIERARCHY 
If you plan to use the My SAFe V4.0 Portfolio project area as a “master” for other SAFe V4.0 Portfolio 

project areas, as opposed to extracting the process template for use in establishing new project areas, 

you can update the Team Area Hierarchy here. However, if you plan to extract a process template for 

use by other projects in your organization, the Team Area Hierarchy and related Work Item Categories 

must be configured in the Eclipse client in SAFe V4.0 Process Template Configurations (Eclipse) later in 

this document.  
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Update the Portfolio Team Area Hierarchy to include your Value Streams.  

1. Launch the Application Administration page for the My SAFe V4.0 Portfolio project area.  

2. In the Team Area Hierarchy on the right, click the Create Team… icon to create a new Team Area:  

 

3. Specify Value Stream 1 (rename) for the name:  

 

4. Save your changes.  

5. Select My SAFe V4.0 Portfolio in the Team Area Hierarchy again and repeat this process to create 

Value Stream 2 (rename).  

6. Save your changes.  

Your Team Area Hierarchy should look like this:  

How do I choose?  

 If you want to use your configured My SAFe V4.0 Portfolio and My SAFe V4.0 Program 

project areas as “masters” to create new child project areas that inherit the master 

process configuration, you do not need to extract process templates. This is beneficial 

because, as enhancements are released in these templates by IBM, you can apply the 

updated configurations in the master and have the enhancements automatically inherited 

by all child project areas. If, however, you want to create new SAFe V4.0 project areas that 

are independent from any master, you will need to ultimately extract process templates 

that are used across your organization and then provide configuration enhancements for 

all of the project areas that use your templates. The decision is yours; if you want to 

extract the process templates, some of the configurations must be performed using the 

Eclipse client, as specified.  
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WORK ITEM CATEGORIES 
If you have created the Team Areas above, create Work Item Categories that correspond to them.  

1. Select the Categories option in the left navigation bar.  

2. Use the Action > Add Category… menu to create new Categories Value Stream 1 (rename) 

and Value Stream 2 (rename): 

  

Your work item categories should look like this:  

 

3. Associate your new Value Stream team areas with these categories by clicking in the Associate 

Project/Team Area space next to the category:  

 

4. Select the appropriate Team Area and then Associate:  
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Your work item categories should now look like this:  

 

5. Save your changes.  

TIMELINES 
In this section, you create a Value Stream iteration to be used by all Value Streams in your Portfolio. If 

you are not intending to implement 4-level SAFe, you can skip this section.  

A single Value Stream iteration assumes that all Value Streams have the same cadence across the 

Portfolio. Even if your Portfolio has more than one Value Stream, this is a simple way to manage all 

releases. However, you can create separate iterations for use by your individual Value Streams if you 

have Value Streams that deliver on different cadences. In any case, in 4-level SAFe, the Programs that 

realize Value Streams are on the cadence set by the Value Stream so you will need to synchronize the 

Value Stream iteration(s) with their associated Program iterations.   

1. Select the Timelines option in the left navigation bar.  

2. Select the Portfolio Timeline and then click the Create Iterations… button:  
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3. In the Create the Iterations dialog, specify Value Stream Roadmap and click OK:  

 

4. With the new Value Stream Roadmap iteration selection, click the Create Iterations… button. In the 

Create the Iterations dialog, specify the name of your Iteration, Value Stream PI Cadence, 

and click OK: 

  

5. With the new Value Stream PI Cadence iteration selected, click Create Iterations… and specify the 

initial set of Program Increments, then click OK: 
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Your updated timeline should look similar to this:  

 

6. Set PI 1 as the current PI using the Set the Selected Iteration as Current icon:  

 

Your updated timeline should look similar to this:  

 

7. Collapse the Value Stream PI Cadence branch of the timeline and then select and drag the Backlog 

iteration to the Value Stream Roadmap iteration so that it appears after Value Stream PI Cadence. 

Your final timeline should look similar to this:  
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8. Save your changes.  

ROLES 
1. Select Roles in the left navigation bar.  

2. Add the new SAFe Value Stream roles by selecting the Create Role icon. Create the Solution 

Architect, Solution Manager, Value Stream Engineer roles, for example:  

Add  

Your Defined Roles should look like this:  

 

PERMISSIONS 

1. Set the permissions for your new roles. You can use the Portfolio Manager and Business Analyst 

roles as models, where:  

Portfolio Manager <> Solution Manager, Value Stream Engineer 

Business Analyst <> Solution Architect 

 

2. Save your changes.  
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WORK ITEMS 
In this section, you add new work item types and make changes to existing work item types.  

HOW DO I GET THE ICONS? 

You may not have all the work item icons referenced in the sections below, but you may find some of 

them in the My SAFe V4.0 Program project area. Alternatively, you can get a set of icons from the SAFe 

4.0 Icons (2016-07-20).zip archive file posted on the SAFe 4.0 Assets page.  

To use them in the My SAFe V4.0 Portfolio project area configuration, you will need to download the 

archive to your local machine and unzip them into a directory.  

1. Launch RTC in the Eclipse client and establish a Repository Connection.  

2. Right-click on the Repository Connection, choose Managed Connected Project Areas and select the 

My SAFe V4.0 Portfolio project area.  

3. Right-click to open the My SAFe V4.0 Portfolio project area.  

4. Click the Process Configuration tab and navigate to Project Configuration > Configuration Data > 

Work Items > Types and Attributes in the Configuration box on the left: 

 

 
 

5. In the Work Item Types pane, select the Icon drop-down and then Manage Icons…  

https://www.ibm.com/developerworks/community/wikis/home?lang=en&cm_mc_uid=97968658639514600559723&cm_mc_sid_50200000=1461599490#!/wiki/W54ecb028c53d_48b0_9d5e_4584a00489d3/page/SAFe%C2%AE%204.0%20Assets
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6. Click the Add Icons… button and navigate to the local directory where you have stored your icons. 

Select each one you’d like to add (use Ctrl key to select multiple icons) and click Open to add them 

to your environment.  

 

Click the OK button when you’re finished. It is easiest to just select all of them and then click Cancel 

when you get a message about a duplicate. This will enable you to add the new ones, but keep those 

that already exist in your environment.  

7. Repeat this process to add Enumeration, State and Action icons by going to the Project 

Configuration > Configuration Data > Work Items > Enumerations and Project Configuration > 

Configuration Data > Work Items > Workflows sections. Note: In the Enumerations section you will 

need to edit an existing Literal in order to add Enumeration Literal icons.  

You should now have all of the work item type, state and action icons used below. Repeat this process in 

the My SAFe V4.0 Program project area if you are missing icons there as well.  
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WORK ITEM ENUMERATIONS 

You must first create some new enumerations and update existing ones before configuring the work 

item types and attributes. 

1. In the My SAFe V4.0 Portfolio project area, select Work Items in the left navigation bar.    

2. Select Enumerations.  

3. Click the Add… button to create a new PI Objective Type enumeration. 

4. Specify the Name and ID: PI Objective Type, piType 

 

5. Select Add… to add literals: Program, Team, Value Stream.  Set Value Stream for the 

Default and Unassigned Literal values:  

 

 

6. Click the Add… button to create a new SAFe Work Type enumeration. 

7. Specify the Name and ID: SAFe Work Type, safeWorkType 
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8. Select Add… to add literals: Enabler, Business.  Set Business for the Default and 

Unassigned Literal values:  

 

9. Click the Add… button to create a new SAFe Enabler Type enumeration. 

10. Specify the Name and ID: SAFe Enabler Type, safeEnablerType 

 

 

11. Select Add… to add literals: Infrastructure, Architecture, Exploration, 

Unassigned. Set Unassigned as the Default and Unassigned Literal values:  
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12. Click the Add… button to create a new Business Value enumeration. 

13. Specify the Name and ID: Business Value, safeBusinessValue: 

 

14. Select Add… to add literals: 0-10. Set 0 as the Default and Unassigned Literal values:  
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15. Click the Add… button to create a new Checklist Item Status enumeration. 

16. Specify the Name and ID: Checklist Item Status, checklistItemStatus 

 

17. Select Add… to add literals: Required, Complete, Not Required.  Set Required for 

the Default and Unassigned Literal values:  
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18. Click the Add… button to create a new How Found enumeration. 

19. Specify the Name and ID: How Found, howFound 

 

20. Select Add… to add literals: Unknown, Customer, Development, Test.  Set Unknown 

for the Default and Unassigned Literal values:  

 
 

21. Click the Add… button to create a new Impact enumeration. 

22. Specify the Name and ID: Impact, impact 

Add your own “How Found” 

enumeration literals as 

required for your 

organization. 
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23. Select Add… to add literals: 20% - Minor, 40% - Moderate, 60% - Major, 80% - 

Critical,and 100% - Blocker.  Set 20% - Minor for the Default and None for the 

Unassigned Literal values:  

 
 

24. Click the Add… button to create a new Probability enumeration. 

25. Specify the Name and ID: Probability, probability 

 

26. Select Add… to add literals: 20% - Very Low, 40% - Low, 60% - Moderate, 80% - 

High,and 100% - Very High.  Set 20% - Very Low for the Default and None for the 

Unassigned Literal values:  
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27. Click the Add… button to create a new Risk Category enumeration. 

28. Specify the Name and ID: Risk Category, riskCategory 

 

 

29. Select Add… to add literals: Socio-cultural, 
Political, Economic, Competitive, 

Technology, Regulatory/Legal, 

Uncertainty/Risk, Market.  Set Socio-cutural 

for the Default and None for the Unassigned Literal values:  

Add your own “Risk 

Category” enumeration 

literals as required for your 

organization. 
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30. Save your changes.  

WORK ITEM TYPES 

PORTFOLIO EPIC 

1. Select Types and Attributes. 

2. Select the Portfolio Epic.  

3. Change the icon so that you can distinguish it from the new Value Stream Epic type you will create 

later: 

  

4. Scroll down to the Attributes section and locate the existing WSJF attribute. Click on the Name field 

to change the name to WSJF (integer): 

 

5. Click Add… to add a new WSJF attribute with these details:  

Name: WSJF 

ID: com.ibm.team.workitem.attribute.wsjfDecimal 

Type: Decimal 
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6. Scroll down to the Attributes section and click Add… to add the SAFe Work Type attribute.  

7. Select the Create Attribute radio button and specify these details:  

Name: SAFe Work Type 

ID: com.ibm.team.workitem.attribute.safeWorkType 

Type: SAFe Work Type 
  

 

8. Click Add… to add the SAFe Enabler Type attribute.  

9. Select the Create Attribute radio button and specify these details:  

Name: SAFe Enabler Type 

ID: com.ibm.team.workitem.attribute.safeEnablerType 

Type: SAFe Enabler Type 
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10. Click Add… to add the Proposed attribute.  

11. Select the Create Attribute radio button and specify these details:  

Name: Proposed 

ID: com.ibm.team.workitem.attribute.proposed 

Type: Iteration 

 

 

12. Click Add… to add the Estimated Story Points attribute.  

13. Select the Create Attribute radio button and specify these details:  

Name: Estimated Story Points 

ID: 
com.ibm.team.workitem.attribute.estimatedStoryPoints 

Type: Integer 

 

 

14. Click Add… to add the Actual Story Points attribute.  

15. Select the Create Attribute radio button and specify these details:  

Name: Actual Story Points 

ID: com.ibm.team.workitem.attribute.actualStoryPoints 

Type: Integer 

Note: If your 

organization prefers 

to reflect “effort” in 

terms of something 

other than Story 

Points, simply 

change the names of 

these attribute. For 

example, you might 

just call them 

Estimated Effort and 

Actual Effort, which 

provides ultimate 

flexibility to measure 

“effort” in terms of 

Story Points, or 

Headcount, or 

Person Months, or 

anything else.  
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16. Click Add… to add a Success Criteria attribute.  

17. Select the Create Attribute radio button and specify these details:  

Name: Success Criteria 

ID: com.ibm.team.workitem.attribute.successCriteria 

Type: Large HTML 

 

 

18. Remove the Epic Type attribute:  

 

19. Save your changes.  

20. Select Editor Presentations.  

21. Select com.ibm.team.editor.portfolioEpic in the Choose the Editor Presentation to edit: selection 

list.  

22. Make sure the Overview section is selected, then click the + on the Details bar: 
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23. Specify these details to add the WSJF, SAFe Work Type, SAFe Enabler Type, Proposed, Estimated 

Story Points and Actual Story Points with these details:  

 

Attribute: WSJF 

Kind: Decimal 

 

Attribute: SAFe Work Type 

Kind: Radio Group 

 

Attribute: SAFe Enabler Type 

Kind: Radio Group 

 

Attribute: Proposed 

Kind: Iteration 

 

Attribute: Estimated Story Points 

Kind: Integer 

 

Attribute: Actual Story Points 

Kind: Integer 

 

24. Make these changes to position the attributes:  

a. Drag and drop the WSJF above renamed WSJF (integer) attribute 

b. Select the Remove Presentation icon next to the original WSJF (integer) attribute to remove 

it 

c. Drag and drop the Estimated Story Points and Actual Story Points under the Progress 

attribute 

d. Drag and drop the Proposed attribute before the Planned For attribute 
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e. Select the Remove Presentation icon next to the “empty” attribute because you deleted the 

Epic Type:  

 

 

 

25. Your updated editor presentation should look like this:  

 

 

26. Click the  under the History section to add a new tab for Success Criteria, specifying these details:  

Title: Success Criteria 

Layout: Custom Attributes Layout 

Create Tab ID: com.ibm.team.tab.successCriteria 
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27. Use the Success Criteria > Move Left menu option to position this new tab after the Overview 

section:  

 

 

28. Select the Success Criteria tab and add a section, specifying these details:  

 

Title: Criteria for Success  

Slot: Right 

Create Section ID: com.ibm.team.workitem.section.criteriaForSuccess  

 
 

 

29. In the new Criteria for Success section, click the + to add an attribute:  
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30. Add another attribute to the Criteria for Success section:  

Non-Attribute-based Presentation 

Kind: Links 

Label: Tested By 

Properties:  

 hideifNoProjectLink tested-by 

 labelVisible true 

 linkTypeFilter [com.ibm.team.workitem.linktype.testedByTestCase] 
 

  
 

31. Your updated editor presentation for the Success Criteria tab should look like this:  
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32. Save your changes.  

33. Select the com.ibm.team.apt.planPreview editor presentation.  

Select Portfolio Epic and add the WSJF, SAFe Work Type, SAFe Enabler Type, Proposed, Estimated 

Story Points and Actual Story Points as you did above. Delete the WSJF (integer) attribute and 

“empty” attribute left behind when you deleted the Epic Type attribute. Your presentation should 

look like this:  

 

34. Save your changes.  

35. Select the com.ibm.team.workitem.web.inline editor presentation.  

Select Portfolio Epic and add the WSJF, SAFe Work Type, SAFe Enabler Type, Proposed, Estimated 

Story Points and Actual Story Points as you did above.    

36. Save your changes. 

 

 

VALUE STREAM EPIC 

1. Select Types and Attributes. 

2. Select Add… to add a new Work Item Type. 

3. Specify these details:  

Name: Value Stream Epic 

ID: com.ibm.team.workitem.workItemType.valueStreamEpic 

Add a new type category: com.ibm.team.workitem.workItemType.valueStreamEpic 

Note: There are some necessary workflow changes but these will be done in the Eclipse client 

because we must add a new State Group to complete the SAFe Kanban workflow. 

Note: If you are using 

the 6.0.1 versions of the 

templates, you will not 

have WSJF or its 

component attributes. 

Add them by just as 

you’ve added the other 

attributes. 
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4. Click OK. 

5. Choose an icon:  

6. Scroll down to the Attributes section.  

7. Click Add… to add a Blocked attribute: 

Name: Blocked 

ID: com.ibm.team.apt.attribute.planitem.blocked 

Type: Boolean 

  

 

8. Click Add… to add a Reason attribute: 

Name: Reason 

ID: com.ibm.team.apt.attribute.planitem.blockedReason 

Type: Medium String 
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9. Add all of the attributes shown below, including the new WSJF attribute, that already exist on the 

Portfolio Epic by clicking Add… for each one and specifying Reuse Existing Attribute. For example:  
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10. Save your changes.  

11. Select Editor Presentations.  

12. Click Add… to create a new com.ibm.team.editor.valueStreamEpic editor presentation:  

 

13. Add the simple header:  

 
 

14. Add the Overview tab by clicking the + to the right of Add Section.  

15. Specify these details: 

Title: Overview 

Layout: Overview Layout 

Create Tab ID:com.ibm.team.tab.valueStreamEpic.overview 
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16. Click the  under the new Overview section to add tabs for Success Criteria, Links, Approvals, and 

History, specifying the details provided below for each section:  

 

Title: Success Criteria 

Layout: Custom Attributes Layout 

Reuse Existing Tab: com.ibm.team.tab.successCriteria 
 

 

 

Title: :Links 

Layout: Links Layout 

Resuse Existing Tab:com.ibm.team.workitem.tab.links 

 

Title: Approvals 

Layout: Approvals Layout 

Resuse Existing Tab:com.ibm.team.workitem.tab.approvals 

 

Title: History 

Layout: History Layout  

Resuse Existing Tab:com.ibm.team.workitem.tab.history 

 

17. Select the Overview tab and click the Add Section link to add sections for Details, Quick Information, 

Description, Discussion, and Summary, specifying the details provided below for each section:  

 

Title: Details 

Slot: Details 

Create Section ID: com.ibm.team.workitem.valueStreamEpic.section.details 
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Title: Quick Information 

Slot: Quick Information 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 

 

Title: Value Statement 

Slot: Description 

Reuse Existing Section: 
com.ibm.team.workitem.section.portfolioEpic.valuestatement 

 

Title: Discussion 

Slot: Discussion 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

 

18. Save your changes.  

19. In the Details section of the Overview tab, click the + to add the following attributes, providing 

these details:  

 

Attribute: Type 

Kind: Enumeration 

 

Non-Attribute-based Presentation: Static Rich Text 

Rich Text: Type Description (with URL link: http://ibm.biz/Bd4xhY) 

 

Attribute: Filed Against 

Kind: Category 

 

Non-Attribute-based Presentation: Work Progress 

 

Attribute: Estimated Story Points 

Kind: Integer 

 

Attribute: Actual Story Points 

Kind: Integer 

http://ibm.biz/Bd4xhY
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Non-Attribute-based Presentation: Team and Project Area 

 

Attribute: Creation Date 

Kind: Timestamp 

 

Attribute: Created By 

Kind: Contributor 

 

Attribute: Tags 

Kind: Tags 

 

Attribute: Owned By 

Kind: Contributor 

 

Attribute: Proposed 

Kind: Iteration 

 

Attribute: Planned For 

Kind: Iteration 

 

Attribute: WSJF 

Kind: Decimal 

 

Attribute: Job Size 

Kind: Enumeration 

 

Attribute: User/Business Value 

Kind: Enumeration 

 

Attribute: Time Criticality 

Kind: Enumeration 

 

Attribute: RROE 

Kind: Enumeration 

 

Attribute: SAFe Work Type 

Kind: Radio Group 

 

Attribute: SAFe Enabler Type 

Kind: Radio Group 

 

Your presentation should look like this:  
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20. Select the Success Criteria tab and add a section, specifying these details:  

 

Title: Criteria for Success  

Slot: Right 

Create Section ID: com.ibm.team.workitem.section.criteriaForSuccess  

 
 

 

21. In the new Criteria for Success section, click the + to add an attribute:  
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22. Add another attribute to the Criteria for Success section:  

Non-Attribute-based Presentation 

Kind: Links 

Label: Tested By 

Properties:  

 hideifNoProjectLink tested-by 

 labelVisible true 

 linkTypeFilter [com.ibm.team.workitem.linktype.testedByTestCase] 
 

  
 

23. Your updated editor presentation for the Success Criteria tab should look like this:  

 

 
24. Save your changes.  

25. Select the com.ibm.team.apt.planPreview editor presentation.  

26. Click the  to add a new tab for Value Stream Epic.  

27. Specify these details: 

Title: Value Stream Epic 

Layout: H Layout 

Create Tab ID: com.ibm.team.apt.planPreview.valueStreamEpic 
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28. Click the Add Section link to add sections for Details, Quick Information, Description, Discussion, and 

Summary specifying the details provided below for each section:  

 

Title: Details 

Slot: Left 

Reuse Existing Section: 
com.ibm.team.workitem.valueStreamEpic.section.details 

 

 
 

Title: Quick Information 

Slot: Right 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 

Key: noHeader, Value: true 

 

Title: Value Statement 

Slot: Bottom 

Reuse Existing Section: 

com.ibm.team.apt.planPreview.portfolioEpic.valueStatement 
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Title: Discussion 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

Key: expanded, Value: false 
 

Title: Summary 

Slot: Top 

Reuse Existing Section: 
com.ibm.team.apt.planPreview.default.section.summary 

Key: noHeader, Value: true 

 

29. Save your changes.  

30. Select the com.ibm.team.workitem.web.inline editor presentation.  

31. Click the  to add a new tab for Value Stream Epic.  

32. Specify these details: 

Title: Value Stream Epic 

Layout: H Layout 

Create Tab ID: com.ibm.team.workitem.web.inline.valueStreamEpic 

 

 
 

33. Click the Add Section link to add sections for Details, Quick Information, Description, Discussion, and 

Summary specifying the details provided below for each section:  

 

Title: Details 

Slot: Left 

Reuse Existing Section: 
com.ibm.team.workitem.valueStreamEpic.section.details 
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Title: Quick Information 

Slot: Right 

Reuse Existing Section: 
com.ibm.team.workitem.web.inline.section.quickinformation 

Key: noHeader, Value: true 

 

Title: Value Statement 

Slot: Bottom 

Reuse Existing Section: 
com.ibm.team.workitem.web.inline.portfolioEpic.valueStatement 

 

Title: Discussion 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.web.inline.section.discussion 

Key: expanded, Value: false 
 

Title: Summary 

Slot: Top 

Create Section ID: com.ibm.team.apt.planPreview.default.section.summary 

Key: noHeader, Value: true 
 

34. Save your changes.  

35. Select Workflows and then Add…  to create a new Value Stream workflow. 

36. Specify the Name and ID: Value Stream Epic Workflow, 
com.ibm.team.workitem.valueStreamEpicWorkflow  



Configuring SAFe V4.0 in CLM 43 8/17/2016 

  

37. Click OK. Ignore the error about no start action… we’re getting there! 

38. Specify these States, Groups and Icons by clicking the Add… option in the States section and adding 

each one: 

 

If you don’t have all of these specific 

icons, choose something you have that makes sense.   

39. Specify these Actions, Target States and Icons by clicking the Add… option in the Actions section 

and adding each one.  

 

40. Specify the Start Action and Resolve Action in the Transitions section. 

 

41. Save your changes.  

42. Select Types and Attributes. 

43. Select Value Stream Epic. 

44. Set the Editors and Workflow as shown below:  

Note: For Value Stream Epic and Capability, we will 

only put basic workflow in place for now. We will 

complete this in the Eclipse client because we must 

add a new State Group to complete the SAFe Kanban 

workflow. 
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45. Save your changes.  

 

CAPABILITY 

1. Select Types and Attributes. 

2. Select Add… to add a new Work Item Type. 

3. Specify these details:  

Name: Capability 

ID: com.ibm.team.workitem.workItemType.capability 

Add a new type category: com.ibm.team.workitem.workItemType.capability 
 

 

4. Click OK. 

5. Choose an icon:  

6. Scroll down to the Attributes section.  

7. Click Add… to add an Acceptance Criteria attribute.  

8. Specify these details:  

Name: Acceptance Criteria 

ID: com.ibm.team.workitem.attribute.acceptanceCriteria 

Type: Large HTML 
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9. Click Add… to add an Acceptance Test attribute.  

10. Specify these details:  

Name: Acceptance Test 

ID: com.ibm.team.workitem.attribute.acceptanceTest 

Type: Checklist Item Status 

 

 

 

11. Add the rest of the “done criteria” checklist item attributes by 

specifying these details for Documentation, Performance Test, UX 

Design:  

Name: Documentation 

ID: com.ibm.team.workitem.attribute.documentation 

Type: Checklist Item Status 
 

Name: Performance Test 

ID: com.ibm.team.workitem.attribute.performanceTest 

Type: Checklist Item Status 
 

Name: UX Design 

ID: com.ibm.team.workitem.attribute.uxDesign 

Type: Checklist Item Status 

 

12. Click Add… to add a Checklist Notes attribute.  

Feel free to add 

any “done 

criteria” attributes 

you would like to 

track in your 

organization. 
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13. Specify these details:  

Name: Checklist Notes 

ID: com.ibm.team.workitem.attribute.checklistNotes 

Type: Wiki 
 

 
 

14. Add the rest of the attributes shown below that already exist in the Value Stream Epic by clicking 

Add… for each one and specifying Reuse Existing Attribute. For example:  
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15. Save your changes.  

16. Select Editor Presentations.  

17. Click Add… to create a new com.ibm.team.editor.capability editor presentation:  

 

18. Add the simple header:  
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19. Add the Overview tab by clicking the + to the right of Add Section.  

20. Specify these details: 

Title: Overview 

Layout: Overview Layout 

Create Tab ID:com.ibm.team.tab.capability.overview 

 

 
 

 

21. Click the  under the new Overview section to add tabs for Acceptance Criteria, Done Criteria, Links, 

Approvals, and History, specifying the details provided below for each section:  

 

Title: Acceptance Criteria 

Layout: Custom Attributes Layout 

Create Tab ID: com.ibm.team.tab.acceptanceCriteria 
 

Title: Done Criteria 

Layout: Custom Attributes Layout 

Create Tab ID: com.ibm.team.tab.doneCriteria 

 

Title: :Links 

Layout: Links Layout 

Resuse Existing Tab:com.ibm.team.workitem.tab.links 

 

Title: Approvals 

Layout: Approvals Layout 

Resuse Existing Tab:com.ibm.team.workitem.tab.approvals 

 

Title: History 

Layout: History Layout  

Resuse Existing Tab:com.ibm.team.workitem.tab.history 

 

22. Select the Overview tab and click the Add Section link to add sections for Details, Quick Information, 

Description, Discussion, and Summary, specifying the details provided below for each section:  
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Title: Details 

Slot: Details 

Create Section ID: com.ibm.team.workitem.capability.section.details 

 

 
 

Title: Quick Information 

Slot: Quick Information 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 

 

Title: Description 

Slot: Description 

Reuse Existing Section: com.ibm.team.workitem.section.description 

 

Title: Discussion 

Slot: Discussion 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

 

23. Save your changes.  

24. In the Details section of the Overview tab, click the + to add the following attributes, specifying 

these details: 

Attribute: Type 

Kind: Enumeration 

 

Non-Attribute-based Presentation: Static Rich Text 

Rich Text: Type Description (with URL link: http://ibm.biz/Bd4xhF) 

 

Attribute: Filed Against 

Kind: Category 

 

Non-Attribute-based Presentation: Work Progress 

 

Attribute: Estimated Story Points 

Kind: Integer 

 

Attribute: Actual Story Points 

Kind: Integer 

http://ibm.biz/Bd4xhF
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Non-Attribute-based Presentation: Team and Project Area 

 

Attribute: Creation Date 

Kind: Timestamp 

 

Attribute: Created By 

Kind: Contributor 

 

Attribute: Tags 

Kind: Tags 

 

Attribute: Owned By 

Kind: Contributor 

 

Attribute: Proposed 

Kind: Iteration 

 

Attribute: Planned For 

Kind: Iteration 

 

Attribute: WSJF 

Kind: Decimal 

 

Attribute: Job Size 

Kind: Enumeration 

 

Attribute: User/Business Value 

Kind: Enumeration 

 

Attribute: Time Criticality 

Kind: Enumeration 

 

Attribute: RROE 

Kind: Enumeration 

 

Attribute: SAFe Work Type 

Kind: Radio Group 

 

Attribute: SAFe Enabler Type 

Kind: Radio Group 

 

 

Your presentation should look like this:  
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25. Save your changes.  

26. Select the Acceptance Criteria tab and then the + Add Section to add a section:  

 

Title: Criteria for Acceptance  

Slot: Right 

Create Section ID: com.ibm.team.workitem.section.criteriaForAcceptance 

 
 

27. In the new Criteria for Acceptance section, click the + to add an attribute:  

Attribute: Acceptance Criteria  

Kind: HTML 
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28. Add another attribute to the Criteria for Acceptance section: 

 

Non-Attribute-based Presentation 

Kind: Links 

Label: Tested By 

Properties:  

 hideifNoProjectLink tested-by 

 labelVisible true 

 linkTypeFilter [com.ibm.team.workitem.linktype.testedByTestCase] 

  
 

29. Save your changes.  

30. Your Acceptance Criteria tab should look like this:  
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31. Select the Done Criteria tab and then the + Add Section to add a section:  

 

Title: Checklist 

Slot: Left 

Create Section ID: com.ibm.team.workitem.section.checklist 

 

 
 

32. In the new Checklist section, click the + to add an attribute:  

Attribute: Acceptance Test  

Kind: Enumeration 

 
 

33. Repeat this process to add Documentation, Performance Test, and UX Design.  

34. Click the + Add Section to add another section:  

 

Title: Checklist Notes 
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Slot: Right 

Create Section ID: com.ibm.team.workitem.section.checklistNotes 
 

 
 

35. In the new Checklist Notes section, click the + to add an attribute:  

Attribute: Checklist Notes 

Kind: Wiki 

 

 

 
 

36. Your Done Criteria tab should look like this:  
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37. Save your changes.  

38. Select the com.ibm.team.apt.planPreview editor presentation.  

39. Click the  to add a new tab for Capability.  

40. Specify these details: 

Title: Capability 

Layout: H Layout 

Create Tab ID: com.ibm.team.apt.planPreview.capability 
 

 
 

41. Click the Add Section link to add sections for Details, Quick Information, Description, Discussion, and 

Summary specifying the details provided below for each section:  

 

Title: Details 

Slot: Left 

Reuse Existing Section: com.ibm.team.workitem.capability.section.details 

 

 
 

Title: Quick Information 

Slot: Right 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 

Key: noHeader, Value: true 
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Title: Description 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.description 

 

Title: Discussion 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

Key: expanded, Value: false 
 

Title: Summary 

Slot: Top 

Reuse Existing Section: 
com.ibm.team.apt.planPreview.default.section.summary 

Key: noHeader, Value: true 

 

42. Save your changes.  

43. Select the com.ibm.team.workitem.web.inline editor presentation.  

44. Click the  to add a new tab for Capability.  

45. Specify these details: 

Title: Capability 

Layout: H Layout 

Create Tab ID: com.ibm.team.workitem.web.inline.capability 

 

 
46. Click the Add Section link to add sections for Details, Quick Information, Description, Discussion, and 

Summary specifying the details provided below for each section:  

 

Title: Details 

Slot: Left 

Reuse Existing Section: com.ibm.team.workitem.capability.section.details 
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Title: Quick Information 

Slot: Right 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 

Key: noHeader, Value: true 

 

Title: Description 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.description 

 

Title: Discussion 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

Key: expanded, Value: false 
 

Title: Summary 

Slot: Top 

Reuse Existing Section: 
com.ibm.team.apt.planPreview.default.section.summary 

Key: noHeader, Value: true 
 

47. Save your changes.  

48. Click Workflows and then Add…  to create a new Capability workflow. 

49. Specify these details:  

Name: Capability Workflow 

ID: com.ibm.team.workitem.capabilityWorkflow  
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50. Click OK. Ignore the error about no start action…  

51. Specify these States, Groups and Icons by clicking the Add… option in the States section and adding 

each one: 

 

If you don’t have all of these specific icons, choose something you have that makes sense.    

52. Specify these Actions, Target States and Icons by clicking the Add… option in the Actions section 

and adding each one.  

 

53. Specify the Start Action and Resolve Action in the Transitions section. 

 

54. Select Types and Attributes. 

55. Select Capability. 

56. Set the Editors and Workflow as shown below:  

 

57. Save your changes.  
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LEARNING MILESTONE 

1. Select Types and Attributes. 

2. Select Add… to add a new Work Item Type. 

3. Specify these details:  

Name: Learning Milestone 

ID: com.ibm.team.workitem.workItemType.learningMilestone 

Add a new type category: 
com.ibm.team.workitem.workItemType.learningMilestone   

 

 

4. Click OK. 

5. Choose an icon:  

6. Select Editor Presentations.  

7. Click Add… to create a new com.ibm.team.editor.learningMilestone editor 

presentation:  

 

8. Add the simple header:  
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9. Add the Overview tab by clicking the + to the right of Add Section.  

10. Specify these details:  

Title: Overview 

Layout: Overview Layout 

Create Tab ID:com.ibm.team.tab.learningMilestone.overview 

 

 
 

 

11. Click the  under the new Overview section to add tabs for Success Criteria, Links, Approvals, and 

History, specifying the details provided below for each section:  

 

Title: Success Criteria 

Layout: Custom Attributes Layout 

Reuse Existing Tab: com.ibm.team.tab.successCriteria 

 

Title: :Links 

Layout: Links Layout 

Resuse Existing Tab:com.ibm.team.workitem.tab.links 

 

Title: Approvals 

Layout: Approvals Layout 

Resuse Existing Tab:com.ibm.team.workitem.tab.approvals 

 

Title: History 

Layout: History Layout  

Resuse Existing Tab:com.ibm.team.workitem.tab.history 

 

12. Select the Overview tab and click the Add Section link to add sections for Details, Quick Information, 

Description, Discussion, and Summary, specifying the details provided below for each section:  

 

Title: Details 
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Slot: Details 

Create Section ID: com.ibm.team.workitem.learningMilestone.section.details 

 

 
 

Title: Quick Information 

Slot: Quick Information 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 

 

Title: Description 

Slot: Description 

Reuse Existing Section: com.ibm.team.workitem.section.description 

 

Title: Discussion 

Slot: Discussion 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

 

13. Save your changes.  

14. In the Details section of the Overview tab, click the + to add the following attributes: 

Attribute: Type 

Kind: Enumeration 
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Non-Attribute-based Presentation: Static Rich Text 

Rich Text: Type Description (with URL link: http://ibm.biz/Bd4xhH) 

 

Attribute: Filed Against 

Kind: Category 

 

Non-Attribute-based Presentation: Team and Project Area 

 

Attribute: Creation Date 

Kind: Timestamp 

 

Attribute: Created By 

Kind: Contributor 

 

Attribute: Tags 

Kind: Tags 

 

Attribute: Owned By 

Kind: Contributor 

 

Attribute: Planned For 

Kind: Iteration 

 

Your presentation should look like this:  

http://ibm.biz/Bd4xhH
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15. Save your changes.  

16. Select the com.ibm.team.apt.planPreview editor presentation.  

17. Click the  to add a new tab for Learning Milestone.  

18. Specify these details: 

Title: Learning Milestone 

Layout: H Layout 

Create Tab ID: com.ibm.team.apt.planPreview.learningMilestone 
 

 
 

19. Click the Add Section link to add sections for Details, Quick Information, Description, Discussion, and 

Summary specifying the details provided below for each section:  

 

Title: Details 

Slot: Left 

Reuse Existing Section: 
com.ibm.team.workitem.learningMilestone.section.details 
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Title: Quick Information 

Slot: Right 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 

Key: noHeader, Value: true 

 

Title: Description 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.description 

 

Title: Discussion 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

Key: expanded, Value: false 
 

Title: Summary 

Slot: Top 

Reuse Existing Section: 
com.ibm.team.apt.planPreview.default.section.summary 

Key: noHeader, Value: true 

 

20. Save your changes.  

21. Select the com.ibm.team.workitem.web.inline editor presentation.  

22. Click the  to add a new tab for Learning Milestone.  

23. Specify these details: 

Title: Learning Milestone 

Layout: H Layout 

Create Tab ID: com.ibm.team.workitem.web.inline.learningMilestone 
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24. Click the Add Section link to add sections for Details, Quick Information, Description, Discussion, and 

Summary specifying the details provided below for each section:  

 

Title: Details 

Slot: Left 

Reuse Existing Section: 
com.ibm.team.workitem.learningMilestone.section.details 

 

 
 

Title: Quick Information 

Slot: Right 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 

Key: noHeader, Value: true 

 

Title: Description 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.description 

 

Title: Discussion 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

Key: expanded, Value: false 
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Title: Summary 

Slot: Top 

Reuse Existing Section: 
com.ibm.team.apt.planPreview.default.section.summary  

Key: noHeader, Value: true 
 

25. Save your changes.  

26. Click Workflows and then Add…  to create a new Milestone workflow. 

27. Specify the Name and ID: Learning Milestone Workflow, 
com.ibm.team.workitem.learningMilestoneWorkflow  

 

28. Click OK. Ignore the error about no start action… we’re getting there! 

29. Specify these States, Groups and Icons by clicking the Add… option in the States section and adding 

each one: 

  

If you don’t have all of these specific icons, choose something you have that makes sense.   

30. Specify these Actions, Target States and Icons by clicking the Add… option in the Actions section 

and adding each one.  
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31. Specify the Start Action, Resolve Action, Reopen Action and these Transitions in the Transitions 

section. 

 

32. Select Types and Attributes. 

33. Select Learning Milestone. 

34. Set the Editors and Workflow as shown below:  

 
35. Save your changes.  

PI OBJECTIVE 

1. Select Types and Attributes. 

2. Select Add… to add a new Work Item Type. 

3. Specify these details: 

Name: PI Objective 

ID: com.ibm.team.workitem.workItemType.piObjective 

Add a new type category: com.ibm.team.workitem.workItemType.piObjective 
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4. Click OK. 

5. Choose an icon:  

 

6. Scroll down to the Attributes section and click Add… to add an Achieved Value (%) attribute. 

7. Select the Create Attribute radio button and specify these details:  

Name: Achieved Value (%) 

ID: com.ibm.team.workitem.attribute.achievedValue 

Type: Integer 

 
8. Click Add… to add the Business Value (actual) attribute.  

9. Select the Create Attribute radio button and specify these details:  

Name: Business Value (actual) 

ID: com.ibm.team.workitem.attribute.busValueActual 

Type: Business Value 

 

Note: You can reference your 

My SAFe V4.0 Program project 

area when specifying the PI 

Objective work item to view 

the attributes, enumerations 

and editors.  
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10. Click Add… to add the Business Value (planned) attribute.  

11. Select the Create Attribute radio button and specify these details:  

Name: Business Value (planned) 

ID: com.ibm.team.workitem.attribute.busValuePlanned 

Type: Business Value 

 

12. Click Add… to add the PI Objective Type attribute.  

13. Select the Create Attribute radio button and specify these details:  

Name: PI Objective Type 

ID: com.ibm.team.workitem.attribute.piType 

Type: PI Objective Type 

 

14. Your new attributes should appear as shown below: 

 
15. Save your changes.  

16. Select Editor Presentations.  

17. Click Add… to create a new com.ibm.team.editor.piObjective editor presentation:  
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18. Add the simple header:  

 
 

19. Add the Overview tab by clicking the + to the right of Add Section.  

20. Specify these details:  

Title: Overview 

Layout: Overview Layout 

Create Tab ID:com.ibm.team.tab.piObjective.overview 

 

 
 

21. Click the  under the new Overview section to add tabs for Links, Approvals, and History, specifying 

the details provided below for each section:  

 

Title: :Links 

Layout: Links Layout 

Resuse Existing Tab:com.ibm.team.workitem.tab.links 

 

Title: Approvals 

Layout: Approvals Layout 
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Resuse Existing Tab:com.ibm.team.workitem.tab.approvals 

 

Title: History 

Layout: History Layout  

Resuse Existing Tab:com.ibm.team.workitem.tab.history 

 

22. Select the Overview tab and click the Add Section link to add sections for Details, Quick Information, 

Description, Discussion, and Summary, specifying the details provided below for each section:  

 

Title: Details 

Slot: Details 

Create Section ID: com.ibm.team.workitem.piObjective.section.details 

 

 
Title: Quick Information 

Slot: Quick Information 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 

 

Title: Description 

Slot: Description 

Reuse Existing Section: com.ibm.team.workitem.section.description 

 

Title: Discussion 

Slot: Discussion 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

 

23. Save your changes.  

24. In the Details section of the Overview tab, click the + to add the following attributes: 

Attribute: Type 

Kind: Enumeration 
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Non-Attribute-based Presentation: Static Rich Text 

Rich Text: Type Description (with URL link: http://ibm.biz/Bd4xhj ) 

 

Attribute: PI Objective Type 

Kind: Radio Group 

 

Attribute: Filed Against 

Kind: Category 

 

Attribute: Tags 

Kind: Tags 

 

Attribute: Owned By 

Kind: Contributor 

 

Attribute: Planned For 

Kind: Iteration 

 

Attribute: Business Value (planned) 

Kind: Enumeration 

 

Attribute: Business Value (actual) 

Kind: Enumeration 

 

Attribute: Achieved value (%) 

Kind: Integer 

 

Your presentation should look like this:  

http://ibm.biz/Bd4xhj
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25. Save your changes.  

26. Select the com.ibm.team.apt.planPreview editor presentation.  

27. Click the  to add a new tab for PI Objective.  

28. Specify these details: 

Title: PI Objective 

Layout: H Layout 

Create Tab ID: com.ibm.team.apt.planPreview.piObjective 
 

 
 

29. Click the Add Section link to add sections for Details, Quick Information, Description, Discussion, and 

Summary specifying the details provided below for each section:  

 

Title: Details 

Slot: Left 

Reuse Existing Section: com.ibm.team.workitem.piObjective.section.details 
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Title: Quick Information 

Slot: Right 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 

Key: noHeader, Value: true 

 

Title: Description 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.description 

 

Title: Discussion 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

Key: expanded, Value: false 
 

Title: Summary 

Slot: Top 

Reuse Existing Section: 
com.ibm.team.apt.planPreview.default.section.summary 

Key: noHeader, Value: true 

 

30. Save your changes.  

31. Select the com.ibm.team.workitem.web.inline editor presentation.  

32. Click the  to add a new tab for PI Objective.  

33. Specify these details: 

Title: PI Objective 

Layout: H Layout 

Create Tab ID: com.ibm.team.web.inline.piObjective 
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34. Click the Add Section link to add sections for Details, Quick Information, Description, Discussion, and 

Summary specifying the details provided below for each section:  

 

Title: Details 

Slot: Left 

Reuse Existing Section: com.ibm.team.workitem.piObjective.section.details 

 
 

Title: Quick Information 

Slot: Right 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 

Key: noHeader, Value: true 

 

Title: Description 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.description 

 

Title: Discussion 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

Key: expanded, Value: false 
 

Title: Summary 

Slot: Top 
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Reuse Existing Section: 
com.ibm.team.apt.planPreview.default.section.summary 

Key: noHeader, Value: true 
 

35. Save your changes.  

36. Click Workflows and then Add…  to create a new PI Objective workflow. 

37. Specify the Name and ID: PI Objective Workflow, 
com.ibm.team.workitem.piObjectiveWorkflow  

 

38. Click OK. Ignore the error about no start action… we’re getting there! 

39. Specify these States, Groups and Icons by clicking the Add… option in the States section and adding 

each one: 

  

If you don’t have all of these specific icons, choose something you have that makes sense.   

40. Specify these Actions, Target States and Icons by clicking the Add… option in the Actions section 

and adding each one.  
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41. Specify the Start Action, Resolve Action, Reopen Action and these Transitions in the Transitions 

section. 

  

42. Select Types and Attributes. 

43. Select PI Objective. 

44. Set the Editors and Workflow as shown below:  

 
45. Save your changes.   

RISK 

1. Select Types and Attributes. 

2. Select Add… to add a new Work Item Type. 

3. Specify these details: 

Name: Risk 

ID: com.ibm.team.workitem.workItemType.risk 

Add a new type category: com.ibm.team.workitem.workItemType.risk 

 

 

4. Click OK. 

Note: You can reference your 

My SAFe V4.0 Program project 

area when specifying the Risk 

work item to view the 

attributes, enumerations and 

editors.  
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5. Choose an icon:  

 

6. Scroll down to the Attributes section and click Add… to add a Contingency Plan attribute. 

7. Select the Create Attribute radio button and specify these details:  

Name: Contingency Plan 

ID: com.ibm.team.workitem.attribute.contingencyPlan 

Type: Large HTML 
 

 
 

8. Repeat these steps to create the rest of the attributes with the specified details:  

Name: Exposure (%) 

ID: com.ibm.team.workitem.attribute.exposure 

Type: Long 
 

Name: Identification Date 

ID: com.ibm.team.workitem.attribute.identificationDate 

Type: Timestamp 
 

Name: Impact  

ID: com.ibm.team.workitem.attribute.impact 

Type: Impact 
 

Name: Mitigation Plan 

ID: com.ibm.team.workitem.attribute.mitigationPlan 

Type: Large HTML 
 

Name: Occurrence Date 

ID: com.ibm.team.workitem.attribute.occurrenceDate 

Type: Timestamp 
 

Name: Probability 

ID: com.ibm.team.workitem.attribute.probability 



Configuring SAFe V4.0 in CLM 79 8/17/2016 

Type: Probability 
 

Name: Risk Category 

ID: com.ibm.team.workitem.attribute.riskCategory 

Type: Risk Category 
 

9. Your new attributes should appear as shown below: 

 

 
 

10. Save your changes.  

11. Select Editor Presentations.  

12. Click Add… to create a new com.ibm.team.editor.risk editor presentation:  

 

13. Add the simple header:  

 
 

14. Add the Overview tab by clicking the + to the right of Add Section.  

15. Specify these details:  

Title: Overview 

Layout: Overview Layout 
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Create Tab ID:com.ibm.team.tab.risk.overview 

 

 
 

16. Click the  under the new Overview section to add tabs for Risk Planning, Links, Approvals, and 

History, specifying the details provided below for each section:  

 

Title: :Risk Planning 

Layout: H Layout 

Create Tab ID: com.ibm.team.workitem.tab.riskPlanning 

 

Title: :Links 

Layout: Links Layout 

Resuse Existing Tab:com.ibm.team.workitem.tab.links 

 

Title: Approvals 

Layout: Approvals Layout 

Resuse Existing Tab:com.ibm.team.workitem.tab.approvals 

 

Title: History 

Layout: History Layout  

Resuse Existing Tab:com.ibm.team.workitem.tab.history 

 

17. Select the Overview tab and click the Add Section link to add sections for Details, Quick Information, 

Description, Discussion, and Summary, specifying the details provided below for each section:  

 

Title: Details 

Slot: Details 

Create Section ID: com.ibm.team.workitem.risk.section.details 
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Title: Quick Information 

Slot: Quick Information 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 

 

Title: Description 

Slot: Description 

Reuse Existing Section: com.ibm.team.workitem.section.description 

 

Title: Discussion 

Slot: Discussion 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

 

18. Save your changes.  

19. In the Details section of the Overview tab, click the + to add the following attributes: 

Attribute: Type 

Kind: Enumeration 
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Non-Attribute-based Presentation: Static Rich Text 

Rich Text: Type Description (with URL link: http://ibm.biz/BdHFKt) 

 

Attribute: Creation Date 

Kind: Timestamp 

 

Attribute: Created By 

Kind: Contributor 
 

Non-Attribute-based Presentation 

Kind: Team and Project Area 

 

Attribute: Filed Against 

Kind: Category 

 

Attribute: Tags 

Kind: Tags 

 

Attribute: Owned By 

Kind: Contributor 

 

Attribute: Priority 

Kind: Enumeration 

 

Attribute: Planned For 

Kind: Iteration 

Label: Identified For 

 

 

Attribute: Resolution Date 

Kind: Timestamp 

 

Attribute: Resolved By 

Kind: Contributor 

 

Attribute: Probability 

Kind: Enumeration 

 

Attribute: Impact 

Kind: Enumeration 

 

Attribute: Exposure (%) 

Kind: Long 

 

http://ibm.biz/BdHFKt
http://ibm.biz/BdHFKt
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Attribute: Risk Category 

Kind: Enumeration 

 

Attribute: Occurrence Date 

Kind: Timestamp 

 

Your presentation should look like this:  

 
 

20. Save your changes.  

21. Select the com.ibm.team.apt.planPreview editor presentation.  

22. Click the  to add a new tab for Risk.  

23. Specify these details: 

Title: Risk 

Layout: H Layout 

Create Tab ID: com.ibm.team.apt.planPreview.risk 
 

 
 

24. Click the Add Section link to add sections for Details, Quick Information, Description, Discussion, and 

Summary specifying the details provided below for each section:  

 

Title: Details 

Slot: Left 

Reuse Existing Section: com.ibm.team.workitem.risk.section.details 
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Title: Quick Information 

Slot: Right 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 

Key: noHeader, Value: true 

 

Title: Description 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.description 

 

Title: Discussion 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

Key: expanded, Value: false 
 

Title: Summary 

Slot: Top 

Reuse Existing Section: 
com.ibm.team.apt.planPreview.default.section.summary 

Key: noHeader, Value: true 

 

25. Save your changes.  

26. Select the com.ibm.team.workitem.web.inline editor presentation.  

27. Click the  to add a new tab for Risk.  

28. Specify these details: 

Title: Risk  

Layout: H Layout 

Create Tab ID: com.ibm.team.web.inline.risk 
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29. Click the Add Section link to add sections for Details, Quick Information, Description, Discussion, and 

Summary specifying the details provided below for each section:  

 

Title: Details 

Slot: Left 

Reuse Existing Section: com.ibm.team.workitem.risk.section.details 

 
 

Title: Quick Information 

Slot: Right 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 

Key: noHeader, Value: true 

 

Title: Description 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.description 

 

Title: Discussion 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

Key: expanded, Value: false 
 

Title: Summary 
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Slot: Top 

Reuse Existing Section: 
com.ibm.team.apt.planPreview.default.section.summary 

Key: noHeader, Value: true 
 

30. Save your changes.  

31. Click Workflows and then Add…  to create a new Risk workflow. 

32. Specify the Name and ID: Risk Workflow, com.ibm.team.workitem.riskWorkflow  

 

33. Click OK. Ignore the error about no start action… we’re getting there! 

34. Specify these Resolutions by clicking the Add… option in the Resolutions section and adding each 

one:  

 

35. Specify these States, Groups and Icons by clicking the Add… option in the States section and adding 

each one: 

 

 

36. Specify these Actions, Target States and Icons by clicking the Add… option in the Actions section 

and adding each one.  
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37. Specify the Start Action, Resolve Action, Reopen Action and these Transitions in the Transitions 

section. 

  

38. Select Types and Attributes. 

39. Select Risk. 

40. Set the Editors and Workflow as shown below:  

 

 
 

41. Save your changes.   

42. Select Enumerations.  

43. Select Epic Type and then click the Remove button to delete it.  
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44. Save your changes. 

DEFECT 

1. Select Types and Attributes. 

2. Select Add… to add a new Work Item Type. 

3. Specify these details: 

Name: Defect 

ID: com.ibm.team.workitem.workItemType.defect 

Add a new type category: 
com.ibm.team.workitem.workItemType.defect 

 

4. Click OK. 

5. Choose an icon:  

6. Add values for Alias: defect, bug 

7. Scroll down to the Attributes section and click Add… to add Blocked, How Found and Reason 

attributes:  

Reuse Existing Attribute: Blocked – Type: Boolean 

 

 

Name: How Found 

ID: com.ibm.team.workitem.attribute.howFound 

Type: How Found 
 

Note: You can reference your 

My SAFe V4.0 Program project 

area when specifying the 

Defect work item to view the 

attributes, enumerations and 

editors.  
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Reuse Existing Attribute: Reason – Type: Medium String 

 
 

8. Save your changes.  

9. Select Editor Presentations.  

10. Click Add… to create a new com.ibm.team.editor.defect editor presentation:  

 

11. Add the simple header:  
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12. Add the Overview tab by clicking the + to the right of Add Section.  

13. Specify these details:  

Title: Overview 

Layout: Overview Layout 

Create Tab ID:com.ibm.team.tab.defect.overview 

 

 
 

14. Click the  under the new Overview section to add tabs for Links, Approvals, and History, specifying 

the details provided below for each section:  

 

Title: :Links 

Layout: Links Layout 

Resuse Existing Tab:com.ibm.team.workitem.tab.links 

 

Title: Approvals 

Layout: Approvals Layout 

Resuse Existing Tab:com.ibm.team.workitem.tab.approvals 

 

Title: History 

Layout: History Layout  

Resuse Existing Tab:com.ibm.team.workitem.tab.history 

 

15. Select the Overview tab and click the Add Section link to add sections for Details, Quick Information, 

Description, Discussion, and Summary, specifying the details provided below for each section:  

 

Title: Details 

Slot: Details 

Create Section ID: com.ibm.team.workitem.defect.section.details 
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Title: Quick Information 

Slot: Quick Information 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 

 

Title: Description 

Slot: Description 

Reuse Existing Section: com.ibm.team.workitem.section.description 

 

Title: Discussion 

Slot: Discussion 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

 

16. Save your changes.  

17. In the Details section of the Overview tab, click the + to add the following attributes: 

Attribute: Type 

Kind: Enumeration 
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Non-Attribute-based Presentation: Static Rich Text 

Rich Text: Type Description (with URL link: http://ibm.biz/BdHFKQ ) 

 

Attribute: Filed Against 

Kind: Category 

 

Attribute: Severity 

Kind: Enumeration 

 

Attribute: Found In 

Kind: Release 

 

Attribute: How Found 

Kind: Enumeration 

 

Non-Attribute-based Presentation 

Kind: Team and Project Area 

 

Attribute: Creation Date 

Kind: Timestamp 

 

Attribute: Created By 

Kind: Contributor 

 

Attribute: Tags 

Kind: Tags 

 

Attribute: Owned By 

Kind: Contributor 

 

Attribute: Priority 

Kind: Enumeration 

 

Attribute: Planned For 

Kind: Iteration 

 

Attribute: Estimate 

Kind: Time Estimates 

 

Attribute: Time Spent 

Kind: Time Spent 

 

Attribute: Due Date 

http://ibm.biz/BdHFKQ
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Kind: Timestamp 

 

Attribute: Resolution Date 

Kind: Timestamp 

 

Attribute: Resolved By 

Kind: Contributor 

 

Your presentation should look like this:  

 
 

18. Save your changes.  

19. Select the com.ibm.team.apt.planPreview editor presentation.  

20. Click the  to add a new tab for Defect.  

21. Specify these details: 

Title: Defect 

Layout: H Layout 

Create Tab ID: com.ibm.team.apt.planPreview.defect 
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22. Click the Add Section link to add sections for Details, Quick Information, Description, Discussion, and 

Summary specifying the details provided below for each section:  

 

Title: Details 

Slot: Left 

Reuse Existing Section: com.ibm.team.workitem.defect.section.details 

 

Title: Quick Information 

Slot: Right 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 

Key: noHeader, Value: true 

 

Title: Description 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.description 

 

Title: Discussion 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

Key: expanded, Value: false 
 

Title: Summary 

Slot: Top 

Reuse Existing Section: 
com.ibm.team.apt.planPreview.default.section.summary 

Key: noHeader, Value: true 

 

23. Save your changes.  

24. Select the com.ibm.team.workitem.web.inline editor presentation.  

25. Click the  to add a new tab for Defect.  

26. Specify these details: 

Title: Defect 

Layout: H Layout 

Create Tab ID: com.ibm.team.web.inline.defect 
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27. Click the Add Section link to add sections for Details, Quick Information, Description, Discussion, and 

Summary specifying the details provided below for each section:  

 

Title: Details 

Slot: Left 

Reuse Existing Section: com.ibm.team.workitem.defect.section.details 

 

Title: Quick Information 

Slot: Right 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 

Key: noHeader, Value: true 

 

Title: Description 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.description 

 

Title: Discussion 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

Key: expanded, Value: false 
 

Title: Summary 

Slot: Top 

Reuse Existing Section: 
com.ibm.team.apt.planPreview.default.section.summary 

Key: noHeader, Value: true 
 

28. Save your changes.  

29. Click Workflows and then Add…  to create a new Defect workflow. 

30. Specify the Name and ID: Defect Workflow, 
com.ibm.team.workitem.defectWorkflow  
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31. Click OK. Ignore the error about no start action… we’re getting there! 

32. Specify these Resolutions and Icons by clicking the Add… option in the Resolutions section and 

adding each one:  

 

33. Specify these States, Groups, Show Resolution values and Icons by clicking the Add… option in the 

States section and adding each one: 

  

34. Specify these Actions, Target States, Resolutions and Icons by clicking the Add… option in the 

Actions section and adding each one.  
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35. Specify the Start Action, Resolve Action, Reopen Action and these Transitions in the Transitions 

section. 

  

36. Select Types and Attributes. 

37. Select Defect. 

38. Set the Editors and Workflow as shown below:  

 

 
39. Save your changes.   

40. Select Enumerations.  

41. Select Epic Type and then click the Remove button to delete it.  

42. Save your changes. 
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RETROSPECTIVE 

1. Select Types and Attributes. 

2. Select Add… to add a new Work Item Type. 

3. Specify these details:  

Name: Retrospective 

ID: com.ibm.team.workitem.workItemType.retrospective 

Add a new type category: 
com.ibm.team.workitem.workItemType.retrospective 

 

 

4. Click OK. 

5. Choose an icon:  

6. Select Editor Presentations.  

7. Click Add… to create a new com.ibm.team.editor.retrospective editor presentation:  

 

8. Add the simple header:  

 
 

Note: You can reference your My SAFe V4.0 

Program project area when specifying the 

Retrospective work item to view the editors.  
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9. Add the Overview tab by clicking the + to the right of Add Section.  

10. Specify these details:  

Title: Overview 

Layout: Overview Layout 

Create Tab ID:com.ibm.team.tab.retrospective.overview 

 

 
 

 

11. Click the  under the new Overview section to add tabs for Links and History, specifying the details 

provided below for each section:  

 

Title: :Links 

Layout: Links Layout 

Resuse Existing Tab:com.ibm.team.workitem.tab.links 

 

Title: History 

Layout: History Layout  

Resuse Existing Tab:com.ibm.team.workitem.tab.history 

 

12. Select the Overview tab and click the Add Section link to add sections for Details, Quick Information, 

Description, Discussion, and Summary, specifying the details provided below for each section:  

 

Title: Details 

Slot: Details 

Create Section ID: com.ibm.team.workitem.retrospective.section.details 
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Title: Quick Information 

Slot: Quick Information 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 

 

Title: Description 

Slot: Description 

Reuse Existing Section: com.ibm.team.workitem.section.description 

 

Title: Discussion 

Slot: Discussion 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

 

13. Save your changes.  

14. In the Details section of the Overview tab, click the + to add the following attributes: 

Attribute: Type 

Kind: Enumeration 

 

 
 

Non-Attribute-based Presentation: Static Rich Text 

Rich Text: Type Description (with URL link: http://ibm.biz/BdHFKw) 

http://ibm.biz/BdHFKw
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Attribute: Filed Against 

Kind: Category 

 

Non-Attribute-based Presentation: Team and Project Area 

 

Attribute: Owned By 

Kind: Contributor 

 

Attribute: Planned For 

Kind: Iteration 

 

Attribute: Resolution Date 

Kind: Timestamp 

 

Attribute: Resolved By  

Kind: Contributor 

 

Your presentation should look like this:  

 
 

15. Save your changes.  

16. Select the com.ibm.team.apt.planPreview editor presentation.  

17. Click the  to add a new tab for Retrospective.  

18. Specify these details: 

Title: Retrospective 

Layout: H Layout 

Create Tab ID: com.ibm.team.apt.planPreview.retrospective 
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19. Click the Add Section link to add sections for Details, Quick Information, Description, Discussion, and 

Summary specifying the details provided below for each section:  

 

Title: Details 

Slot: Left 

Reuse Existing Section: com.ibm.team.workitem.retrospective.section.details 

 

 
 

Title: Quick Information 

Slot: Right 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 

Key: noHeader, Value: true 

 

Title: Description 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.description 

 

Title: Discussion 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

Key: expanded, Value: false 
 

Title: Summary 

Slot: Top 
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Reuse Existing Section: 
com.ibm.team.apt.planPreview.default.section.summary 

Key: noHeader, Value: true 

 

20. Save your changes.  

21. Select the com.ibm.team.workitem.web.inline editor presentation.  

22. Click the  to add a new tab for Retrospective.  

23. Specify these details: 

Title: Retrospective 

Layout: H Layout 

Create Tab ID: com.ibm.team.workitem.web.inline.retrospective 
 

 

 

24. Click the Add Section link to add sections for Details, Quick Information, Description, Discussion, and 

Summary specifying the details provided below for each section:  

 

Title: Details 

Slot: Left 

Reuse Existing Section: com.ibm.team.workitem.retrospective.section.details 

 

 
 

Title: Quick Information 

Slot: Right 

Reuse Existing Section: com.ibm.team.workitem.section.quickinformation 
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Key: noHeader, Value: true 

 

Title: Description 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.description 

 

Title: Discussion 

Slot: Bottom 

Reuse Existing Section: com.ibm.team.workitem.section.discussion 

Key: expanded, Value: false 
 

Title: Summary 

Slot: Top 

Reuse Existing Section: 
com.ibm.team.apt.planPreview.default.section.summary  

Key: noHeader, Value: true 
 

25. Save your changes.  

26. Click Workflows and then Add…  to create a new Retrospective workflow. 

27. Specify the Name and ID: Retrospective Workflow, 
com.ibm.team.workitem.retrospectiveWorkflow  

 

28. Click OK. Ignore the error about no start action… we’re getting there! 

29. Specify these States, Groups and Icons by clicking the Add… option in the States section and adding 

each one: 

  

30. Specify these Actions, Target States and Icons by clicking the Add… option in the Actions section 

and adding each one.  
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31. Specify the Start Action, Resolve Action, Reopen Action and these Transitions in the Transitions 

section. 

 

32. Select Types and Attributes. 

33. Select Retrospective. 

34. Set the Editors and Workflow as shown below:  

 

 
 

35. Save your changes.  

CHANGE MANAGEMENT TYPE BINDING 
Before continuing, set up the type bindings for the work item types to indicate things like which reflect 

plan items or defects.  

1. Select Change Management Type Binding. 

2. Specify the following:  
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3. Save your changes.  

QUERIES 
In this section you will create new queries to support additions in SAFe 4.0.  

1. In the top right of the Application Administration – Change and Configuration Management (CCM), 

select the Explore Project link.  

2. Create a new Work Item query by selecting Work Items > Create Query in the menu bar.  

3. Name your new query Capability “Done Criteria” Status and add conditions as 

shown below:  

 

4. Click Details and then +Add Team or Project Area… to share your query:  

 

5. Save your changes. Later you will add this to the Predefined queries in the Eclipse client and add a 

dashboard widget to display the results of this query.  
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SAFE V4.0 PROGRAM CONFIGURATIONS (BROWSER) 

TIMELINES 
In this section, you update the Program timeline so that it includes a Roadmap iteration that 

encapsulates both the ART iteration as well as the Backlog.  

1. Launch the Application Administration page for the My SAFe V4.0 Program project area. 

2. Select the Timelines option in the left navigation bar.  

3. Select the (Program Name) Timeline and then click the Create Iterations… button:  

 

4. In the Create the Iterations dialog, specify (Program Name) Roadmap and click OK:  

 

Your updated timeline should look similar to this:  

 

5. Select and drag the Backlog and (Program Name) Agile Release Train iterations so that they appear 

after the (Program Name) Roadmap iteration. Your final timeline should look similar to this:  
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6. Save your changes.  

WORK ITEMS 
In this section, you update existing work item types.  

WORK ITEM ENUMERATIONS 

You must first create some new enumerations and update existing ones before configuring the work 

item types and attributes. 

1. Launch the Application Administration page for the My SAFe V4.0 Program project area.  

2. Select Work Items in the left navigation bar and then Enumerations.  

3. Edit the Business Value enumeration and select Add… to add the 0 literal. Move it to the top of the 

Literals list and set 0 as the Default and Unassigned Literal values:  
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4. Click the Add… button to create a new SAFe Work Type enumeration. 

5. Specify the Name and ID: SAFe Work Type, safeWorkType 

 

6. Select Add… to add literals: Enabler, Business.  Set Business for the Default and 

Unassigned Literal values:  
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7. Click the Add… button to create a new SAFe Enabler Type enumeration. 

8. Specify the Name and ID: SAFe Enabler Type, safeEnablerType 

 

 

9. Select Add… to add literals: Infrastructure, Architecture, Exploration, 

Unassigned. Set Unassigned as the Default and Unassigned Literal values:  
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10. Click the Add… button to create a new Checklist Item Status enumeration. 

11. Specify the Name and ID: Checklist Item Status, checklistItemStatus 

 

12. Select Add… to add literals: Required, Complete, Not Required.  Set Required for 

the Default and Unassigned Literal values:  

 
 

13. Click the Add… button to create a new How Found enumeration. 

14. Specify the Name and ID: How Found, howFound 
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15. Select Add… to add literals: Unknown, Customer, Development, Test.  Set Unknown 

for the Default and Unassigned Literal values:  

 

 

16. Save your changes.  

WORK ITEM TYPES 

PROGRAM EPIC 

1. Select Types and Attributes. 

2. Select Program Epic. 

3. Scroll down to the Attributes section and locate the existing WSJF attribute. Click on the Name field 

to change the name to WSJF (integer): 

 

4. Click Add… to add a new WSJF attribute with these details:  

Name: WSJF 

ID: com.ibm.team.workitem.attribute.wsjfDecimal 

Type: Decimal 

Add your own “How Found” 

enumeration literals as 

required for your 

organization. 
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5. Scroll down to the Attributes section and click Add… to add the SAFe Work Type attribute.  

6. Specify these details:  

Name: SAFe Work Type 

ID: com.ibm.team.workitem.attribute.safeWorkType 

Type: SAFe Work Type 
  

 

7. Click Add… to add the SAFe Enabler Type attribute.  

8. Specify these details:  

Name: SAFe Enabler Type 

ID: com.ibm.team.workitem.attribute.safeEnablerType 

Type: SAFe Enabler Type 
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9. Click Add… to add the Blocked attribute:  

Resuse Existing Attribute: Blocked – Type: Boolean 

 

 

10. Click Add… to add the Reason attribute:  

Resuse Existing Attribute: Reason – Type: Medium String 

 

 

 

11. Click Add… to add the Proposed attribute.  

12. Select the Create Attribute radio button and specify these details:  

Name: Proposed 

ID: com.ibm.team.workitem.attribute.proposed 

Type: Iteration 
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13. Click Add… to add the Estimated Story Points attribute.  

14. Select the Create Attribute radio button and specify these details:  

Name: Estimated Story Points 

ID: 
com.ibm.team.workitem.attribute.estimatedStoryPoints 

Type: Integer 

 

 

15. Click Add… to add the Actual Story Points attribute.  

16. Select the Create Attribute radio button and specify these details:  

Name: Actual Story Points 

ID: com.ibm.team.workitem.attribute.actualStoryPoints 

Type: Integer 

Note: If your 

organization prefers 

to reflect “effort” in 

terms of something 

other than Story 

Points, simply 

change the names of 

these attribute. For 

example, you might 

just call them 

Estimated Effort and 

Actual Effort, which 

provides ultimate 

flexibility to measure 

“effort” in terms of 

Story Points, or 

Headcount, or 

Person Months, or 

anything else.  
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17. Click Add… to add a Success Criteria attribute.  

18. Specify these details:  

Name: Success Criteria 

ID: com.ibm.team.workitem.attribute.successCriteria 

Type: Large HTML 

 

 

19. Remove the Epic Type attribute:  

 

20. Save your changes.  

21. Select Editor Presentations.  

22. Select com.ibm.team.editor.programEpic in the Choose the Editor Presentation to edit: selection 

list.  

23. Make sure the Overview section is selected, then click the + on the Details bar to add the following 

attributes, providing these details:  

 

Attribute: Estimated Story Points 

Kind: Integer 

 

Attribute: Actual Story Points 

Kind: Integer 

 

Attribute: Proposed 
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Kind: Iteration 

 

Attribute: WSJF 

Kind: Decimal 

 

Attribute: SAFe Work Type 

Kind: Radio Group 

 

Attribute: SAFe Enabler Type 

Kind: Radio Group 

 

 

24. Make these changes to position the attributes:  

a. Drag and drop the WSJF above renamed WSJF (integer) attribute 

b. Select the Remove Presentation icon next to the original WSJF (integer) attribute to remove 

it 

c. Drag and drop the Estimated Story Points and Actual Story Points under the Progress 

attribute 

d. Drag and drop the Proposed attribute before the Planned For attribute 

e. Select the Remove Presentation icon next to the “empty” attribute because you deleted the 

Epic Type:  

 

 

 

25. Your updated editor presentation should look like this:  
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26. Click the  under the History section to add a new tab for Success Criteria, specifying these details:  

Title: Success Criteria 

Layout: Custom Attributes Layout 

Create Tab ID: com.ibm.team.tab.successCriteria 
 

 
 

27. Use the Success Criteria > Move Left option to position this new tab after the Overview section:  

 

 

28. Select the Success Criteria tab and add a section:  
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Title: Criteria for Success  

Slot: Right 

Create Section ID: com.ibm.team.workitem.section.criteriaForSuccess  

 
 

 

29. In the new Criteria for Success section, click the + to add the Success Criteria attribute:  

 

 
 

30. Add another attribute for linked test cases and specify the following details:  

Non-Attribute-based Presentation 

Kind: Links 

Label: Tested By 

Properties:  

 hideifNoProjectLink tested-by 

 labelVisible true 

 linkTypeFilter [com.ibm.team.workitem.linktype.testedByTestCase] 
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31. Your updated editor presentation should look like this:  

 

 

32. Save your changes.  

33. Select the com.ibm.team.apt.planPreview editor presentation.  

34. Select the Program Epic tab and add the WSJF, SAFe Work Type, SAFe Enabler Type, Proposed, 

Planned For, Estimated Story Points and Actual Story Points as you did above. Delete the “empty” 

attribute left behind when you deleted the Epic Type attribute. Your presentation should look like 

this:  
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35. Save your changes.  

36. Select the com.ibm.team.workitem.web.inline editor 

presentation.  

37. Select the Program Epic tab and add the WSJF, Job Size, User/Business Value, Time Criticality, RROE, 

SAFe Work Type, SAFe Enabler Type, Estimated Story Points and Actual Story Points as you did 

above, specifying the following details: 

Attribute: WSJF, Kind: Decimal 

Attribute: Job Size, Kind: Enumeration 

Attribute: User/Business Value, Kind: Enumeration 

Attribute: Time Criticality, Kind: Enumeration 

Attribute: RROE, Kind: Enumeration 

Attribute: SAFe Work Type, Kind: Radio Group 

Attribute: SAFe Enabler Type, Kind: Radio Group 

Attribute: Estimated Story Points, Kind: Integer 

Attribute: Actual Story Points, Kind: Integer 

Attribute: Proposed,Kind: Iteration 
 

38. Delete the WSJF (integer) and the “empty” attribute left behind when you deleted the Epic Type 

attribute. Your presentation should look like this: 

 
 

39. Save your changes.  

Note: If you are using 

the 6.0.1 versions of the 

templates, you will not 

have WSJF or its 

component attributes. 

Add them by following 

the instructions 

provided for the 

web.inline editor below. 
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FEATURE 

1. Select Types and Attributes. 

2. Select Feature. 

3. Scroll down to the Attributes section and locate the existing WSJF attribute. Click on the Name field 

to change the name to WSJF (integer): 

 

 

4. Add all of the attributes shown below that already exist on the Program Epic by clicking Add… for 

each one and specifying Reuse Existing Attribute. For example:  
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5.  Select the existing Acceptance Test attribute and change the name to Acceptance Criteria: 

 
 

6. Click Add… to add an Acceptance Test attribute and specify these details:  

Name: Acceptance Test 

ID: com.ibm.team.workitem.attribute.acceptanceTest 

Type: Checklist Item Status 

 

 

 

7. Add the rest of the “done criteria” checklist item attributes by 

specifying these details for Documentation, Performance Test, UX 

Design:  

Name: Documentation 

ID: com.ibm.team.workitem.attribute.documentation 

Type: Checklist Item Status 
 

Name: Performance Test 

ID: com.ibm.team.workitem.attribute.performanceTest 

Type: Checklist Item Status 
 

Name: UX Design 

ID: com.ibm.team.workitem.attribute.uxDesign 

Type: Checklist Item Status 

 

8. Click Add… to add a Checklist Notes attribute and specify these details:  

Name: Checklist Notes 

ID: com.ibm.team.workitem.attribute.checklistNotes 

Type: Wiki 
 

Feel free to add 

any “done 

criteria” attributes 

you would like to 

track in your 

organization. 
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9. Remove the Feature Type attribute:  

 

10. Save your changes.  

11. Select Editor Presentations.  

12. Select com.ibm.team.editor.feature in the Choose the Editor Presentation to edit: selection list.  

13. Click the + under the History section to add a tab for Done Criteria, specifying the details provided 

below:   
 

Title: Done Criteria 

Layout: Custom Attributes Layout 

Create Tab ID: com.ibm.team.tab.doneCriteria 

14. Use the Move Left option to move this new tab just after the Acceptance tab:  

 

15. Select the Acceptance tab and edit it to change the name to Acceptance Criteria. Your tabs should 

now look like this: 

 

16. Make sure the Overview section is selected, then click the + on the Details bar to add the following 

attributes, providing these details:  
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Attribute: Estimated Story Points 

Kind: Integer 

 

Attribute: Actual Story Points 

Kind: Integer 

 

Attribute: Proposed 

Kind: Iteration  

 

Attribute: WSJF 

Kind: Decimal 

 

Attribute: SAFe Work Type 

Kind: Radio Group 

 

Attribute: SAFe Enabler Type 

Kind: Radio Group 

 

17. Make these changes to position the attributes:  

a. Drag and drop the WSJF above renamed WSJF (integer) attribute 

b. Select the Remove Presentation icon next to the original WSJF (integer) attribute to remove 

it 

c. Drag and drop the Estimated Story Points and Actual Story Points under the Progress 

attribute 

d. Drag and drop the Proposed attribute before the Planned For attribute 

e. Select the Remove Presentation icon next to the “empty” attribute because you deleted the 

Feature Type:  

 

 

 

18. Your updated editor presentation should look like this:  
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19. Select the Done Criteria tab and then the + Add Section to add a section:  

 

Title: Checklist 

Slot: Left 

Create Section ID: com.ibm.team.workitem.section.checklist 

 

 
 

20. In the new Checklist section, click the + to add an attribute: Che 

Attribute: Acceptance Test  

Kind: Enumeration 
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21. Repeat this process to add Documentation, Performance Test, and UX Design. Your Done Criteria tab 

should look like this:  

 

22. Click the + Add Section to add another section:  

 

Title: Checklist Notes 

Slot: Right 

Create Section ID: com.ibm.team.workitem.section.checklistNotes 
 

 
 

23. In the new Checklist Notes section, click the + to add an attribute:  

Attribute: Checklist Notes 

Kind: Wiki 
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24. Your Done Criteria tab should look like this:  

 

 
 

25. Save your changes.  

26. Select the com.ibm.team.apt.planPreview editor presentation.  

27. Select the Feature tab and add the WSJF, SAFe Work Type, SAFe Enabler Type, Proposed, Planned 

For, Estimated Story Points and Actual Story Points as you did above. Delete the WSJF (integer) 

attribute and the “empty” attribute left behind when you deleted the Feature Type attribute and 

move the Estimated Story Points and Actual Story Points below the Progress attribute. 

Note: You will have to select Show already configured attributes to configure the new attributes in 

this section.  

 

28. Your presentation should look like this:  

 

29. Save your changes.  

Note: If you are using 

the 6.0.1 versions of the 

templates, you will not 

have WSJF or its 

component attributes. 

Add them by following 

the instructions 

provided for the 

web.inline editor below. 
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30. Select the com.ibm.team.workitem.web.inline editor presentation.  

31. Select the Feature tab and add the WSJF, Job Size, User/Business Value, Time Criticality, RROE, SAFe 

Work Type, SAFe Enabler Type, Estimated Story Points, Actual Story Points and Proposed as you did 

above, specifying the following details: 

Attribute: WSJF, Kind: Decimal 

Attribute: Job Size, Kind: Enumeration 

Attribute: User/Business Value, Kind: Enumeration 

Attribute: Time Criticality, Kind: Enumeration 

Attribute: RROE, Kind: Enumeration 

Attribute: SAFe Work Type, Kind: Radio Group 

Attribute: SAFe Enabler Type, Kind: Radio Group 

Attribute: Estimated Story Points, Kind: Integer 

Attribute: Actual Story Points, Kind: Integer 

Attribute: Proposed, Kind: Iteration 
 

 

 

32. Delete the WSJF (integer) attribute and the “empty” attribute left behind when you deleted the Epic 

Type attribute. Your presentation should look like this: 

 

 
 

33. Save your changes.  

STORY 

1. Select Types and Attributes. 

2. Select Story. 

3. Scroll down to the Attributes section.  

4. Select the existing Acceptance Test attribute and change the name to Acceptance Criteria: 
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5. Click Add… to add a numeric Story Points attribute and specify these details:  

Name: Story Points (numeric) 

ID: com.ibm.team.workitem.attribute.storyPointsNumeric 

Type: Integer 

 

6. Add the attributes shown below that already exist in the Feature by clicking Add… for each one and 

specifying Reuse Existing Attribute. For example:  

 

 

7. Save your changes.  

8. Select Editor Presentations.  

9. Select com.ibm.team.apt.editor.story in the Choose the Editor Presentation to edit: selection list.  

10. Click the + under the History section to add a tab for Done Criteria, specifying the details provided 

below:   
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Title: Done Criteria 

Layout: Custom Attributes Layout 

Reuse Existing Tab: com.ibm.team.tab.doneCriteria 

 
 

11. Use the Move Left option to move this new tab just after the Acceptance tab:  

 

12. Select the Acceptance tab and edit it to change the name to Acceptance Criteria. Your tabs should 

now look like this: 

 

13. Select the Overview tab, then click the + on the Details bar:  

 

 
 

14. Select Attribute-based Presentation, SAFe Work Type and Radio Group for Kind. 
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15. Click the + on the Details bar and add SAFe Enabler Type. 

 

 
 

 

16. Your updated editor presentation should look like this:  
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17. Save your changes.  

18. Select the com.ibm.team.apt.planPreview editor presentation.  

19. Select the Story tab and add the SAFe Work Type and SAFe Enabler Type as you did above.  

Note: You will have to select Show already configured attributes to configure the new attributes in 

this section.  

 

20. Save your changes.  

21. Select the com.ibm.team.workitem.web.inline editor presentation.  

22. Select the Story tab and add the SAFe Work Type and SAFe Enabler Type as you did above.  

23. Save your changes.  

PI OBJECTIVE 

1. Select Editor Presentations, then select the com.ibm.team.apt.planPreview presentation.  

2. With PI Objective selected, click the + in the Details header to add a new presentation:  

  

3. Add the Filed Against attribute (you will need to select Show already configured attributes): 
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4. Repeat this process to add the Filed Against attribute in the com.ibm.team.workitem.web.inline PI 

Objective editor presentation.  

5. Save your changes.  

6. Click Workflows and then select PI Objective Workflow.  

7. Update the States, Groups and Icons so that they look like this, using the Add… option to add the 

new Reviewed state and clicking on the Name and Icon fields to change the others:   

 

If you don’t have all of these specific icons, choose something you have that makes sense.   

8. Update the Actions, Target States and Icons, using the Add… option to add the new Reviewed 

action and clicking on the Name and Icon fields to change the others: 

 

9. Ensure the Start Action, Resolve Action, Reopen Action and Transitions in the Transitions section 

are specified as below:  
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10. Save your changes.  

DEFECT 

4. Select Types and Attributes. 

5. Select Defect.  

6. Scroll down to the Attributes section and click Add… to add the How Found attribute.  

7. Specify these details:  

Name: How Found 

ID: com.ibm.team.workitem.attribute.howFound 

Type: How Found 
 

 
 

8. Save your changes.  

9. Select Editor Presentations.  

10. Select com.ibm.team.workitem.editor.default in the Choose the Editor Presentation to edit: 

selection list.  

11. Select the Overview tab, then click the + on the Details bar:  

 

 
 

12. Select Attribute-based Presentation, How Found and Enumeration for Kind. 
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Drag the new attribute just below the Found In attribute.  

 

 

13. Your updated editor presentation should look like this:  

 

14. Save your changes.  

15. Select the com.ibm.team.apt.planPreview editor presentation.  

16. Select the Default tab and add the How Found attribute as you did above. Your presentation should 

look like this:  

 

17. Save your changes.  

18. Select the com.ibm.team.workitem.web.inline editor presentation.  

19. Select the Default tab and add the How Found attribute as you did above. Your presentation should 

look like this 

 

20. Save your changes.  
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QUERIES 
In this section you will create new queries to support additions in SAFe 4.0.  

1. In the top right of the Appliation Administration – Change and Configuration Management (CCM), 

select the Explore Project link.  

2. Create a new Work Item query by selecting Work Items > Create Query in the menu bar.  

3. Name your new query Feature “Done Criteria” Status and add conditions as shown 

below:  

 

4. Click Details and then +Add Team or Project Area… to share your query:  

 

5. Repeat these steps to create the Story “Done Criteria” Status query.  

6. Save your changes. Later you will add this to the Predefined queries in the Eclipse client and add a 

dashboard widget to display the results of this query.  

SAFE V4.0 PROCESS TEMPLATE CONFIGURATIONS (ECLIPSE) 
The next set of changes must be performed in the Eclipse client.  

1. Launch RTC in the Eclipse client and establish a Repository Connection.  

2. Right-click on the Repository Connection, choose Managed Connected Project Areas and select the 

My SAFe V4.0 Program and My SAFe V4.0 Portfolio project areas.  

TIMELINES 
In this section, you designate the Backlog iteration that you created earlier on both the Portfolio and 

Program timelines as RTC’s Backlog Iteration. Perform these steps in each project area.  
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1. Right-click to open the My SAFe V4.0 Portfolio project area.  

2. Click the Process Configuration tab and navigate to Project Configuration > Configuration Data > 

Planning > General in the Configuration box on the left: 

 

 
 

3. In the Backlog Iteration box, expand the Portfolio timeline to expose the Backlog iteration.  

4. With the Backlog iteration selected, make it the designated backlog iteration by clicking the icon in 

the top right corner:  

 

Ignore the warning.  

5. Save your changes.  

6. Right-click to open the My SAFe V4.0 Program project area and repeat these steps. 

WORK ITEM WORKFLOW 
In this section, you update the Kanban workflows to be consistent with the SAFe V4.0 specifications.  

PORTFOLIO EPIC WORKFLOW 

The Portfolio Kanban in SAFe V4.0 involves five “queues”: Funnel, Review, Analysis, Backlog, and 

Implementation.  

1. Right-click to open the My SAFe V4.0 Portfolio project area.  

2. Click the Process Configuration tab and navigate to Project Configuration > Configuration Data > 

Work Items > Workflows in the Configuration box on the left: 
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3. Select Portfolio Epic Workflow in the Choose the Workflow to Edit: selection list.  

4. Scroll to the State Groups section at the bottom. Click Add… to add a new Review State Group. 

Specify these details:  

Name: Review 

Category: In Progress 

OSLC Groups: In Progress 

Icon: review.gif 
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5. Repeat this process to add a new Implementation State Group. Specify these details:  

Name: Implementation 

Category: In Progress 

OSLC Groups: In Progress 

Icon: implementation.png 

 

Note: The Kanban plan view is sensitive to the order of State Groups. Because this dialog does not 

allow you to change the State Group order, you must do that in the process configuration XML. We 

will do that as the next step in this section.  

6. Save your changes and Refresh using the Save and Refresh actions in the top right:  

 

7. Click the Process Configuration Source tab and search for stateGroupDefinition. In the 

source, make the following changes:  

a. Move the Review state group to just after the Funnel state group 

b. Move the Implementation state group to just after the Backlog state group 

c. Change the id of the Review state group to review 

d. Change the id of the Implementation state group to Implementation 

You’re updated stateGroupDefinition section should look like this:  
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8. Save your changes and return to the Process Configuration tab. Notice that the order of State 

Groups has been been changed:  

 

9. Scroll to the States section and make the following changes:  

a. Change Reviewed to Reviewing and change the the State Group to Review 

b. Change the Implementing state group to Implementation 

 

10. Save your changes and Refresh.  

11. Scroll to the Actions section and make the following changes:  

a. Change New to Initialize 

b. Delete and re-add the Rework action with a target state of Analyzing 

  

12. Save your changes and Refresh.  

13. Scroll to the Transitions section and ensure the transitions reflect what is shown below:  
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14. Save your changes and Refresh.  

VALUE STREAM EPIC WORKFLOW 

In SAFe V4.0, the Value Stream Epic Kanban involves three “queues”: Funnel, Review, and Analysis.  

1. Select Value Stream Epic Workflow in the Choose the Workflow to Edit: selection list.  

2. Scroll to the States section and add Rejected, Approved, Analyzing, Reviewing and Ready (for 

Approval) states, as shown below:   

 

3. Save your changes and Refresh.  

4. Scroll to the Actions section and add Analyze, Approve, Ready, Reject, Reopen, Review and Rework 

actions, as shown below:   
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5. Save your changes and Refresh.  

6. Scroll to the Transitions section and ensure the transitions reflect what is shown below:  

 

7. Save your changes and Refresh.  

CAPABILITY WORKFLOW 

In SAFe V4.0, the Capability Kanban involves four “queues”: Funnel, Analysis, Backlog, and 

Implementation. At every PI boundary, the top Capabilities (ranked by WSJF) are pulled from the Backlog 

queue for implementation.  

1. Select Capability Workflow in the Choose the Workflow to Edit: selection list.  

2. Scroll to the States section and add Analyzing, Ready (for Approval), Approved, Rejected and  

Implementing, as shown below:   

 

3. Save your changes and Refresh.  
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4. Scroll to the Actions section and add Analyze, Approve, Implement, Ready, Reject and Reopen, as 

shown below:   

 

5. Save your changes and Refresh.  

6. Scroll to Transitions and make the following updates so that your workflow transitions reflect this 

configuration:  

 

7. Save your changes.  

PROGRAM EPIC WORKFLOW 

In SAFe V4.0, the Program Epic Kanban is precisely the same as the Value Stream Epic Kanban. You make 

the same changes here as you did in the Value Stream Epic Workflow section above.  

1. Right-click to open the My SAFe V4.0 Program project area.  

2. Click the Process Configuration tab and navigate to Project Configuration > Configuration Data > 

Work Items > Workflows in the Configuration box on the left: 
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3. Select Program Epic Workflow in the Choose the Workflow to Edit: selection list.  

4. Scroll to the State Groups section at the bottom. Click Add… to add a new Review State Group. 

Specify these details:  

Name: Review 

Category: In Progress 

OSLC Groups: In Progress 

Icon: review.gif 
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5. Repeat this process to add a new Implementation State Group. Specify these details:  

Name: Implementation 

Category: In Progress 

OSLC Groups: In Progress 

Icon: implementation.png 

 

Note: The Kanban plan view is sensitive to the order of State Groups. Because this dialog does not 

allow you to change the State Group order, you must do that in the process configuration XML. We 

will do that as the next step in this section.  

6. Save your changes and Refresh using the Save and Refresh actions in the top right:  
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7. Click the Process Configuration Source tab and search for stateGroupDefinition. In the 

source, make the following changes:  

a. Move the Review state group to just after the Funnel state group 

b. Move the Implementation state group to just after the Backlog state group 

c. Change the id of the Review state group to review 

d. Change the id of the Implementation state group to Implementation 

You’re updated stateGroupDefinition section should look like this:  

 

8. Save your changes and return to the Process Configuration tab. Notice that the order of State 

Groups has been been changed:  

 

9. Scroll to the States section and update it as shown below:   

 

10. Save your changes and Refresh.  

11. Scroll to the Actions section and update them as shown below:   
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12. Save your changes and Refresh.  

13. Scroll to the Transitions section and ensure the transitions reflect what is shown below:  

 

14. Save your changes and Refresh.  

FEATURE WORKFLOW 

In SAFe V4.0, the Feature Kanban is precisely the same as the Capability Kanban. You make the same 

changes here as you did in the Capability Workflow section above with some additional states to refine 

the phases of implementation.  

1. Select Feature Workflow in the Choose the Workflow to Edit: selection list.  

2. Scroll to the States section and make the following changes:  

a. Change New to Draft associated with the Funnel Group 

b. Change Integration to Integrating 

c. Change the Group for Implementing, Integrating and Testing to Implementation 

d. Change the Group for Done to Closed 

e. Remove the Invalid state 

f. Add the following states: Approved, Analyzing, Rejected, Ready (for Approval) with the 

Groups shown. 
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3. Save your changes and Refresh.  

4. Scroll to the Actions section and and make the following changes:  

g. Change Complete to Close 

h. Change Start Working to Implement 

i. Add the following actions: Analyze, Approve, Reject, and Ready with the Target States shown 

below: 

 

 

5. Save your changes and Refresh.  

6. Scroll to Transitions and make the following updates so that your workflow transitions reflect this 

configuration:  
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7. Save your changes.  

WORK ITEM ATTRIBUTES 

CALCULATED WSJF 

We are adding a decimal version of the WSJF calculated attribute to enable more precision. The same 

calculation will be used to provide both the integer and decimal WSJF values, but some changes are 

required in the JavaScript. Perform these steps in both the My SAFe V4.0 Portfolio and My SAFe V4.0 

Program project areas.  

1. In the My SAFe V4.0 Portfolio project area, click the Process Configuration tab and navigate to 

Project Configuration > Configuration Data > Work Items > Attribute Customization in the 

Configuration box on the left: 
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2. In the Attribute Customization pane, expand Calculated Values and click Calculated WSJF.  

3. Copy-paste the following JavaScript to replace the JavaScript already specified for this calculation:  

/******************************************************************************* 

* Licensed Materials - Property of IBM 

* (c) Copyright IBM Corporation 2015. All Rights Reserved. 

* 

* Note to U.S. Government Users Restricted Rights:   

* Use, duplication or disclosure restricted by GSA ADP Schedule  

* Contract with IBM Corp.  

*******************************************************************************/ 

dojo.provide("com.ibm.team.workitem.attribute.wsjfValueProvider"); 

 

(function() { 

 var doDebug= true;  

    var scriptName= "wsjfCalculator"; 

  

dojo.declare("com.ibm.team.workitem.attribute.wsjfValueProvider", null, { 

 

        getValue: function(attribute, workItem, configuration) { 

         // Grab the enumeration label for each of the WSJF component attributes   

   var jobSizeLabel= workItem.getLabel("com.ibm.team.workitem.attribute.jobSize"); 

   var ubValLabel= workItem.getLabel("com.ibm.team.workitem.attribute.ubVal"); 

   var timeCritLabel= workItem.getLabel("com.ibm.team.workitem.attribute.timeCrit");  

   var rroeLabel= workItem.getLabel("com.ibm.team.workitem.attribute.rroe"); 

    

   // Declare the numeric WSJF attributes 

   var jobSize= 0, ubVal= 0, timeCrit= 0, rroe= 0;  

    

   // Set the numeric attributes based on the enumeration label 

   // User/Business Value 

   ubVal= calc(ubValLabel, 0); 

    

   // Time Criticality 

   timeCrit= calc(timeCritLabel, 0); 

    

   // RR/OE 

   rroe= calc(rroeLabel, 0); 

       

   // Job Size 
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   jobSize= calc(jobSizeLabel, 1); 

    

   var costOfDelay= ubVal + timeCrit + rroe;  

    

   var wsjfString = Number(costOfDelay / jobSize).toFixed(2);  

 

                    var wsjf = Number(wsjfString);  

             

   return wsjf; 

 

   function calc(a_label, default_val) {  

    var result= default_val; 

        switch (a_label) { 

     case '1':  

      result= 1;  

      break; 

     case '2':  

      result= 2; 

      break; 

     case '3': 

      result= 3; 

      break; 

     case '5':  

      result= 5; 

      break; 

     case '8':  

      result= 8; 

      break; 

     case '13': 

      result= 13; 

      break; 

     case '20': 

      result= 20; 

      break;  

        } 

       return result; 

   } 

        } 

 }); 
})(); 

4. Click the Save As… button to save this script to your local machine so that you can load it into the 

My SAFe V4.0 Portfolio project area:  

 

5. Save your changes.  

6. In the My SAFe V4.0 Portfolio project area, go to the Attribute Customization pane, expand 

Calculated Values and select Calculated WSJF. Click the Load… button to load the script you saved 

above into this Script box:  
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7. Save your changes.  

VALUE STATEMENT 

We are formalizing the articulation of the Success Criteria in the SAFe V4.0 templates, so to eliminate 

redundancy, we must remove the Success Criteria section of the Value Statement attribute. Perform 

these steps in both the My SAFe V4.0 Portfolio and My SAFe V4.0 Program project areas.  

1. In the Attribute Customization pane, expand Default Values and click Value Statement. Remove the 

Success Criteria section of the configuration text:  

 

2. Save your changes.  

Make sure you perform these changes for both project areas! 

CALCULATED ACHIEVED VALUE 

In the SAFe V4.0 templates, we are allowing for a value of 0 for Business Value (planned) and Business 

Value (actual) in the PI Objective work item type. As a result, the calculation for Achieved Value (%) must 

be updated. Note that this calculation only exists in your My SAFe V4.0 Program project area. It will 

need to be updated there and created in My SAFe V4.0 Portfolio project area.  
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1. In the My SAFe V4.0 Program project area, go to the Attribute Customization pane, expand 

Calculated Values and click Calculated Achieved Value.  

 

2. In the configuration box, replace the existing script with this code:  

/******************************************************************************* 

* Licensed Materials - Property of IBM 

* (c) Copyright IBM Corporation 2015. All Rights Reserved. 

* 

* Note to U.S. Government Users Restricted Rights:   

* Use, duplication or disclosure restricted by GSA ADP Schedule  

* Contract with IBM Corp.  

*******************************************************************************/ 

dojo.provide("com.ibm.team.workitem.attribute.achievedValueProvider"); 

 

(function() { 

  

dojo.declare("com.ibm.team.workitem.attribute.achievedValueProvider", null, { 

 

        getValue: function(attribute, workItem, configuration) { 

         // Grab the enumeration label for business value attributes   

   var busValuePlannedLabel= 

workItem.getLabel("com.ibm.team.workitem.attribute.busValuePlanned"); 

   var busValueActualLabel= 

workItem.getLabel("com.ibm.team.workitem.attribute.busValueActual"); 

    

   // Declare the numeric business value attributes 

   var busValPlanned= 0, busValActual= 0;  

    

   // Set the numeric attributes based on the enumeration label 

   // Business Value (planned) 

   busValPlanned= calc(busValuePlannedLabel, 1); 

 

   // Business Value (actual) 

   busValActual= calc(busValueActualLabel, 1); 

 

 

   var achievedValueRatio = 0; 

   var achievedValue = 0; 

   if (busValPlanned > 0 & busValActual > 0) { 

    achievedValueRatio= Number(busValActual / busValPlanned); 

       achievedValue= achievedValueRatio * 100; 

   } else; 

    

   return achievedValue; 

 

   function calc(a_label, default_val) {  

    var result= default_val; 

        switch (a_label) { 

        case '0': 

         result= 0; 
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         break; 

     case '1':  

      result= 1;  

      break; 

     case '2':  

      result= 2; 

      break; 

     case '3': 

      result= 3; 

      break; 

     case '4':  

      result= 4; 

      break; 

     case '5':  

      result= 5; 

      break; 

     case '6': 

      result= 6; 

      break; 

     case '7': 

      result= 7; 

      break; 

     case '8': 

      result= 8; 

      break; 

     case '9': 

      result= 9; 

      break; 

     case '10': 

      result= 10; 

      break;  

        } 

       return result; 

   } 

        } 

 }); 

})(); 

3. Save your changes.  

4. Click the Save As… button to save this script to your local machine so that you can load it into the 

My SAFe V4.0 Portfolio project area:  

 

5. In the My SAFe V4.0 Portfolio project area, go to the Attribute Customization pane, expand 

Calculated Values and click the Add…  button to create the Calculated Achieved Value:  
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6. Specify these details and click OK:  

Name: Calculated Achieved Value 

Type: Calculated Values 

Provider: Script Based Calculated Value 

 

7. Click the Load… button to load the script you saved above into this Script box:  

 

8. Save your changes.  

9. In the Configuration pane on the left, navigate to Work Items > Types and Attributes.  

10. Select the PI Objective work item type and scroll down to Attributes.  

11. Select the Achieved Value (%) attribute and then Edit… to add the calculation:  
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12. Specify these details:  

Calculated Value: Calculated Achieved Value 

Dependencies: Business Value (planned), Business Value (actual) 

 

13. After clicking OK, the Calculated Value appears in the Attributes box for this attribute:  

 

14. Save your changes. 

EXPOSURE PROVIDER 

We are adding the Risk work item type to the SAFe Portfolio project area so in this section we will copy 

the Exposure Provider script-based calculated value from the My SAFe V4.0 Program project area.  

1. In the My SAFe V4.0 Program project area, go to the Attribute Customization pane, expand 

Calculated Values and click on Exposure Provider.  
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2. In the configuration box, click the Save As… button to save this script to your local machine so that 

you can load it into the My SAFe V4.0 Portfolio project area:  

 

3. In the My SAFe V4.0 Portfolio project area, go to the Attribute Customization pane, expand 

Calculated Values and click the Add…  button to create the Exposure Provider:  

 

4. Specify these details and click OK:  

Name: Exposure Provider 

Type: Calculated Values 

Provider: Script Based Calculated Value 
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5. Click the Load… button to load the script you saved above into this Script box:  

 

6. Save your changes.  

7. In the Configuration pane on the left, navigate to Work Items > Types and Attributes.  

8. Select the Risk work item type and scroll down to Attributes.  

9. Select the Exposure (%) attribute and then Edit… to add the calculation, specifying these details:  

Calculated Value: Exposure Provider 

Dependencies: Impact, Probability 

  

10. Click OK. The Calculated Value appears in the Attributes box for this attribute:  
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11. Save your changes. 

NUMERIC STORY POINTS 

We’ve added an attribute to hold the numeric value of the Story Points (Complexity) attribute, which is 

an enumeration. The new attribute, Story Points (numeric), will be set via a calculation based on the 

Story Points enumerated value.  

1. In the My SAFe V4.0 Program project area, go to the Attribute Customization pane, selected 

Calculated Values and click the Add… button:  

 

2. Specify these details and click OK:  

Name: Calculated Story Points (Numeric) 

Type: Calculated Values 

Provider: Script Based Calculated Value 
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3. Copy-paste this script into the Configuration box:  

/******************************************************************************* 

* Licensed Materials - Property of IBM 

* (c) Copyright IBM Corporation 2015. All Rights Reserved. 

* 

* Note to U.S. Government Users Restricted Rights:   

* Use, duplication or disclosure restricted by GSA ADP Schedule  

* Contract with IBM Corp.  

*******************************************************************************/ 

dojo.provide("com.ibm.team.workitem.attribute.numStoryPtsValueProvider"); 

 

(function() { 

 var doDebug= true;  

    var scriptName= "numericStoryPointsCalculator"; 

  

dojo.declare("com.ibm.team.workitem.attribute.numStoryPtsValueProvider", null, { 

 

        getValue: function(attribute, workItem, configuration) { 

         // Grab the enumeration label for the Story Points attribute   

   var storyPtsLabel= 

workItem.getLabel("com.ibm.team.apt.attribute.complexity"); 

    

   // Declare the numeric Story Points attributes 

   var numStoryPts= 0;  

    

   // Set the numeric attribute based on the enumeration label 

   numStoryPts= calc(storyPtsLabel, 0); 

    

   return numStoryPts; 

 

   function calc(a_label, default_val) {  

    var result= default_val; 

        switch (a_label) { 

     case 'XS (1 pt)':  

      result= 1;  

      break; 

     case 'S (2 pts)':  

      result= 2; 

      break; 

     case 'M (3 pts)': 

      result= 3; 

      break; 

     case 'L (5 pts)':  

      result= 5; 

      break; 

     case 'XL (8 pts)':  

      result= 8; 

      break; 

     case 'XXL (13 pts)': 

      result= 13; 

      break; 
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     case 'XXXL (21 pts)': 

      result= 21; 

      break;  

        } 

       return result; 

   } 

        } 

 }); 

})(); 

4. Save your changes.  

5. In the Configuration pane on the left, navigate to Work Items > Types and Attributes.  

6. Select the Story work item type and scroll down to Attributes.  

7. Select the Story Points (numeric) attribute and then Edit… to add the calculation, specifying these 

details:  

Calculated Value: Calculated Story Points (Numeric) 

Dependencies: Story Points 
 

  

8. Click OK. The Calculated Value appears in the Attributes box for this attribute:  

 

9. Save your changes. 
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UPDATE “DECIMAL” WSJF 

In both the Portfolio and Program templates, we are changing the WSJF attribute to be a decimal type. 

We’ve added the new attribute in the previous sections. Now we need to update the attributes to use 

the Calculated WSJF Calculated Value, remove the integer version of the attribute and synchronize with 

any existing work items. Perform these steps in both the My SAFe V4.0 Portfolio and My SAFe V4.0 

Program project areas. 

1. In the My SAFe V4.0 Portfolio project area, go to the Configuration pane and navigate to Work 

Items > Types and Attributes.  

2. Select the Portfolio Epic work item type and scroll down to Attributes.  

3. Select the WSJF decimal attribute and then Edit… to add the calculation:  

 

4. Specify these details:  

Calculated Value: Calculated WSJF 

Dependencies: Time Criticality, Job Size, RROE, User/Business Value 

 

5. After clicking OK, the Calculated Value appears in the Attributes box for this attribute:  
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6. Save your changes. 

7. Click on the Check attributes usages in repository hyperlink in the top right of the Attributes box and 

synchronize with any existing work items:  

 

8. Select the Value Stream Epic and Capability work item types and synchronize changes with any 

existing work items.  

9. Repeat this entire process in the My SAFe Va4.0 Program project area.  

 

WORK ITEM TEMPLATES 
In this section, we import the Portfolio and Program Work Item Templates into the process templates. 

Perform these steps in both the My SAFe V4.0 Portfolio and My SAFe V4.0 Program project areas.  

1. Download the portfolio_wi_templates.zip archive file and unzip it into a local directory. You should 

have these XML files as a result:  

 

2. Right-click to open the My SAFe V4.0 Portfolio project area.  

3. Repeat the import process to import each template:  

a. Select File > Import… and, in the Import dialog box, select Team > Work Item Template then 

click next:  
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b. Click the Browse button to navigate to the template and import it into your project area. 

Make sure to check both Option checkboxes:  

 

c. Click Finish. Confirm that all Portfolio Work Item Templates have been imported by 

navigating to New Work Item >  New Work Items from Template… : 
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4. Download the program_wi_templates.zip archive file and unzip it into a local directory. You should 

have these XML files as a result:  

 

5. Right-click to open the My SAFe V4.0 Program project area.  

6. Repeat the import process to import each template:  

a. Select File > Import… and, in the Import dialog box, select Team > Work Item Template then 

click next:  
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b. Click the Browse button to navigate to the template and import it into your project area. 

Make sure to check both Option checkboxes:  

 

c. Click Finish. Confirm that all Portfolio Work Item Templates have been imported by 

navigating to New Work Item >  New Work Items from Template… : 
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Congratulations on your progress so far! You have completed your updates to the My SAFe V4.0 

Portfolio project area. Next you configure the changes required to bring the Program template up to the 

SAFe V4.0 level.  

WORK ITEM PREDEFINED QUERIES 
In this section, we designate new Queries as Predefined Queries and add dashboard widgets. Do this in 

both the Portfolio and Program project areas.  

1. Right-click to open the My SAFe V4.0 Portfolio project area if it is not already opened.  

2. Click the Process Configuration tab and navigate to Project Configuration > Configuration Data > 

Work Items > Predefined Queries 



Configuring SAFe V4.0 in CLM 169 8/17/2016 

 

3. In the Predefined Queries pane, click Add… to add a predefined query. Navigate to the Capability 

“Done Criteria” Status query, select it and click OK:  

 

4. Save your changes.  

5. Repeat this process to add the Feature “Done Criteria” Status and Story “Done Criteria” Status 

predefined queries in the My SAFe V4.0 Program project area. Your predefined query list for the 

Program should include these:  



Configuring SAFe V4.0 in CLM 170 8/17/2016 

 

6. Save your changes.  

PLANS 
In this section, you update the Plan elements that will enable you to show the new attributes in plan 

views. Note that, if you are extracting process templates, these changes must be made in the process 

XML so additional steps will be required below in the Extract Process Templates section. Perform these 

steps in both the My SAFe V4.0 Portfolio and My SAFe V4.0 Program project areas.  

1. In the My SAFe V4.0 Portfolio project area, click the Process Configuration tab and navigate to 

Project Configuration > Configuration Data > Planning > Plan Attributes in the Configuration box on 

the left: 

 

 

2. Set the Complexity Attribute to Estimated Story Points and the Ranking Attribute to User/Business 

Value:  
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3. Expand the Attributing Mapping section, and make the following changes:  

a. Select Epic Type and then the Remove button to remove this attribute 

b. Click the Add button and then add each of these attributes: WSJF, SAFe Enabler Type, SAFe 

Work Type, Estimated Story Points, Actual Story Points, Proposed, Business Value (planned), 

Business Value (actual), Achieved Value (%), and PI Objective Type.  

4. Navigate to Project Configuration > Configuration Data > Planning > Plan View Elements in the 

Configuration box on the left. Click the + in the Groupings box to add: SAFe Work Type, SAFe 

Enabler Type, PI Objective Type, for example:   

 

The resulting Groupings box shows the new attributes:  

  

5. In the Sorting box, click the + to add: Business Value (planned), Business Value 

(actual), SAFe Work Type, SAFe Enabler Type, Job Size, RROE, Time 

Criticality, User/Business Value. The resulting Sorting box shows the new attributes:  



Configuring SAFe V4.0 in CLM 172 8/17/2016 

   

6. Save your changes.  

7. In the My SAFe V4.0 Program project area, click the Process Configuration tab and navigate to 

Project Configuration > Configuration Data > Planning > Plan Attributes in the Configuration box on 

the left. 

8. Change the Ranking Attribute to User/Business Value.  

9. Expand the Attributing Mapping section, and make the following changes:  

a. Select Feature Type and Epic Type and then the Remove button to remove these attributes. 

b. Click the Add button and then add each of these attributes: SAFe Enabler Type, SAFe Work 

Type, Proposed, Estimated Story Points, Actual Story Points and Achieved Value (%) 

10. Navigate to Project Configuration > Configuration Data > Planning > Plan View Elements in the 

Configuration box on the left. Click the + in the Groupings box to add: SAFe Work Type, SAFe 

Enabler Type, PI Objective Type, as you did above.  

11. In the Sorting box, click the + to add: Business Value (planned), Business Value 

(actual), SAFe Work Type, SAFe Enabler Type, Job Size, RROE, Time 

Criticality, User/Business Value. The resulting Sorting box shows the new attributes:  

   

12. Save your changes.  

13. In the My SAFe V4.0 Program project area, click the Process Configuration tab and navigate to 

Project Configuration > Configuration Data > Planning > Work Item Type Categorization in the 

Configuration box on the left. 

14. Select the Feature, PI Objective, Program Epic, and Story as Plan Items:  
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15. Repeat these steps in the My SAFe V4.0 Portfolio project area to select Capability, Learning 

Milestone, PI Objecctive, Portfolio Epic, and Value Stream Epic as Plan Items:  

 

16. Save your changes and close both project areas. 

EXTRACT PROCESS TEMPLATES 
You are now ready to extract the process templates you’ve configured in your project areas.  

1. Right-click on the My SAFe V4.0 Portfolio project area and select Extract Process Template… 

2. Specify the following: 

Name: My SAFe V4.0 Portfolio Process 

Process ID: safe40.portfolio.process 

Summary: Customized process template for SAFe V4.0 Portfolio 
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3. Click Finish. The new process template is opened for editing. Leave it opened and return to the 

Project Area hierarchy.  

4. Right-click on the My SAFe V4.0 Program project area and select Extract Process Template… 

5. Specify the following: 

Name: My SAFe V4.0 Program Process 

Process ID: safe40.program.process 

Summary: Customized process template for SAFe V4.0 Program 
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6. Click Finish. The new process template is opened for editing.  

UPDATE SAFE V4.0 PORTFOLIO PROCESS TEMPLATE 
In this section, we update the following elements in the Portfolio process template: 

 Team Area Hierarchy: Add Value Streams as team areas within the Portfolio project area 

 Work Item Categories: Add Value Stream categories for the Value Stream team areas 

 Plan Types, Modes & Filters: Add the Value Stream Backlog plan type with plan modes for 

Kanban, Roadmap and WSJF Ranked List view along with the necessary filters.  

 

TEAM AREA HIERARCHY 

In this section, we add the new Value Stream team areas.  

1. In the My SAFe V4.0 Portfolio Process, click the Process Configuration Source tab.  

2. Locate the <followup-actions> section in the XML. Copy and paste the following XML into 

that section so that the actions appear first:   

 

     <followup-action 
xmlns="http://com.ibm.team.process/createTeamAreas" description="Initializes the project area 
with default team areas." id="com.ibm.team.process.server.createTeamAreas" name="Create Team 
Areas" optional="false"> 
      <teamArea name="Value Stream 1 (rename)"/> 
      <teamArea name="Value Stream 2 (rename)"/> 
     </followup-action> 
     <followup-action 
xmlns="http://com.ibm.team.process/setUpProject" description="Initializes the project area 
with default categories." id="com.ibm.team.process.server.setUpProject" name="Set Up 
Categories" optional="false"> 
      <workitems> 
       <category htmlDescription="Value Stream 1 
(rename)" path="Portfolio Name (rename)/Value Stream 1 (rename)"/> 
       <category htmlDescription="Value Stream 2 
(rename)" path="Portfolio Name (rename)/Value Stream 2 (rename)"/> 
      </workitems> 
     </followup-action> 

 

3. Save your changes.  

PLANS 

In this section, we update the Portfolio plans and add new plans for the Value Streams.  

1. Select the Overview tab in the My SAFe V4.0 Portfolio Process template. In the Timelines section, 

select the Value Stream Roadmap and click the Edit Properties… button:  

Note: In the following sections, you will be copying and pasting XML source into the Process 

Configuration Source. Unless otherwise indicated, you can paste that source at the end of any 

section, taking care to ensure that the formatting is correct and no XML errors are introduced.  
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2. Change the Identifier to: valueStreamRoadmap 

 

3. Select the Value Stream PI Cadence and click the Edit Properties… button:  

 

4. Change the Identifier to: valueStreamPICadence 

  

5. Repeat this to edit each of the PI x iterations and change the identifier to: piX 
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6. Click on the Process Configuration tab and navigate to Project Configuration > Configuration Data > 

Work Items > Attribution Customization:  

 

7. Expand Default Values and click to edit Default Planned For Iteration. Change the Iteration value to 

/portfolio-timeline/valueStreamRoadmap/backlog by clicking Select… and 

choosing the Backlog iteration: 

 

8. Save your changes.  

9. Click on the Process Configuration Source tab. 

10. Locate the existing XML section:  

<followup-action xmlns="http://com.ibm.team.apt/setUpProject" description="Initializes the project 
area with the plans." id="com.ibm.team.apt.service.setUpProject" name="Set Up Project for Plans"> 

11. Replace this entire <plans> section within that <followup-action> with this XML:  
 
<plans> 
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<plan iterationPath="/portfolio-timeline/valueStreamRoadmap" name="Portfolio Name (rename) 
Roadmap" typeId="com.ibm.team.apt.plantype.portfolioBacklog"/> 

<plan iterationPath="/portfolio-timeline/valueStreamRoadmap" name="Value Stream 1 (rename) 
Roadmap" ownerPath="Value Stream 1 (rename)" typeId="com.ibm.team.apt.plantype.valueStreamBacklog"/> 

<plan iterationPath="/portfolio-timeline/valueStreamRoadmap/valueStreamPICadence/pi1" name="Value 
Stream 1 (rename) PI 1" ownerPath="Value Stream 1 (rename)" 
typeId="com.ibm.team.apt.plantype.valueStreamBacklog"/> 

<plan iterationPath="/portfolio-timeline/valueStreamRoadmap" name="Value Stream 2 (rename) 
Roadmap" ownerPath="Value Stream 2 (rename)" typeId="com.ibm.team.apt.plantype.valueStreamBacklog"/> 

<plan iterationPath="/portfolio-timeline/valueStreamRoadmap/valueStreamPICadence/pi1" name="Value 
Stream 2 (rename) PI 1" ownerPath="Value Stream 2 (rename)" 
typeId="com.ibm.team.apt.plantype.valueStreamBacklog"/> 
</plans> 
12. Search for <planmode id="com.ibm.team.apt.viewmodes.internal.portfolioKanbanBoard":  

 

 
13. Add a filter after the <sortmode> section:  

<filters> 
<filter definition="com.ibm.team.apt.filter.excludeNonPortfolioEpics"/> 

   </filters> 
 

14. Scroll to the <viewmode> and update the “kanban-config” parameter as follows: 
<parameter key="kanban-config" value="{&quot;analysis&quot;:5,&quot;review&quot;:10}"/> 

 

15. Search for <planmode id="com.ibm.team.apt.viewmodes.internal.portfolioRoadmap":  

 

 
16. Update the <viewmode> section on the next line to look like this:  

 
<viewmode definition="com.ibm.team.apt.internal.viewmode.tree" /> 

 
17. Update the columns shown in the Portfolio Roadmap report by copy-pasting the following section to 

replace the <columns> section:  
     <columns> 
      <column 
attribute="com.ibm.team.apt.attribute.planitem.id" width="10"/> 
      <column 
attribute="com.ibm.team.apt.attribute.owner" width="15"/> 
      <column 
attribute="com.ibm.team.apt.attribute.planitem.state" width="10"/> 
      <column 
attribute="com.ibm.team.apt.attribute.planitem.plannedFor" width="15"/> 
      <column 
attribute="com.ibm.team.apt.attribute.planitem.filedAgainst" width="15"/> 
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      <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.wsjf" width="10" /> 
      <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.jobSize" width="10" /> 
      <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.ubVal" width="10" /> 
      <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.timeCrit" width="10" 
/> 
      <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.rroe" width="10"/> 
      <column 
attribute="planning/source/com.ibm.team.workitem.linktype.trackedworkitem/trackedBy" 
width="10" /> 
     </columns> 

 
18. Save your changes.  
19. Search for <plantype id="com.ibm.team.apt.plantype.portfolioBacklog":  

 

20. Add a new <plantype> section for the Value Stream plan type and modes by copy-pasting this XML 

after the portfolioBacklog <plantype> section: 

    <plantype id="com.ibm.team.apt.plantype.valueStreamBacklog" 
name="Value Stream Backlog" icon="icons/obj16/backlog_plan_obj.gif"> 
     <planitems 
definition="com.ibm.team.apt.planitems.projectReleasePlan" /> 
     <planmodes 
default="com.ibm.team.apt.viewmodes.internal.valueStreamKanbanBoard"> 
      <planmode 
definition="com.ibm.team.apt.viewmodes.internal.valueStreamKanbanBoard"/> 
      <planmode 
definition="com.ibm.team.apt.viewmodes.internal.capabilityKanbanBoard"/> 
      <planmode 
definition="com.ibm.team.apt.viewmodes.internal.valueStreamRoadmap"/> 
      <planmode 
definition="com.ibm.team.apt.viewmodes.internal.valueStreamWSJFRankedList"/> 
     </planmodes> 
    </plantype>   

 

21. Search for <configuration-data xmlns="http://com.ibm.team.apt.configuration/planModes":  

 

22. Add a new set of <planmode> sections for the Value Stream Kanban, Capability Kanban, Roadmap 

and WSJF Ranked List plan views by copying and pasting this entire section at the bottom of the 

planModes configuration section:  

        <planmode 
id="com.ibm.team.apt.viewmodes.internal.valueStreamKanbanBoard" name="Value Stream Kanban 
View" progressMode="NONE"> 
           <columns> 
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               <column attribute="com.ibm.team.apt.attribute.summary" 
width="100"> 
                   <parameters> 
                       <parameter key="SMALL" value="true"/> 
                       <parameter key="MEDIUM" value="true"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column> 
               <column attribute="com.ibm.team.apt.attribute.owner" 
width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="true"/> 
                       <parameter key="MEDIUM" value="true"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column> 
               <column 
attribute="com.ibm.team.apt.attribute.planitem.plannedFor" width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="false"/> 
                       <parameter key="MEDIUM" value="true"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column> 
               <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.wsjf" width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="true"/> 
                       <parameter key="MEDIUM" value="true"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column> 
      <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.jobSize" width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="false"/> 
                       <parameter key="MEDIUM" value="false"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column>                
               <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.ubVal" width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="false"/> 
                       <parameter key="MEDIUM" value="false"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column> 
               <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.timeCrit" width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="false"/> 
                       <parameter key="MEDIUM" value="false"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column>           
               <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.rroe" width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="false"/> 
                       <parameter key="MEDIUM" value="false"/> 
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                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column> 
               <column 
attribute="planning/source/com.ibm.team.workitem.linktype.parentworkitem" width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="false"/> 
                       <parameter key="MEDIUM" value="true"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column>                
               <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.apt.attribute.planitem.blocked" 
width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="true"/> 
                       <parameter key="MEDIUM" value="true"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column>                
           </columns> 
           <viewmode 
definition="com.ibm.team.apt.internal.viewmode.kanban"> 
               <parameters> 
                <parameter key="State Group &lt;open&gt;" value="true"/> 
                <parameter key="State Group &lt;backlog&gt;" 
value="true"/> 
                <parameter key="State Group &lt;inprogress&gt;" 
value="true"/> 
                <parameter key="State Group &lt;invalid&gt;" 
value="true"/> 
                <parameter key="State Group &lt;done&gt;" value="true"/> 
                <parameter key="State Group &lt;implementation&gt;" 
value="true"/> 
                   <parameter key="closed-Closed" value="true"/>  
                                   
             <parameter key="kanban-config" 
value="{&quot;review&quot;:10,&quot;analysis&quot;:5}"/> 
               </parameters> 
           </viewmode> 
           <filters> 
      <filter 
definition="com.ibm.team.apt.filter.excludeNonValueStreamEpics"/> 
     </filters> 
           <groupmode definition="com.ibm.team.apt.groupmode.none"/> 
            <sortmode definition="com.ibm.team.apt.sortmode.wsjf"/> 
       </planmode> 
    <planmode 
id="com.ibm.team.apt.viewmodes.internal.capabilityKanbanBoard" name="Capability Kanban View" 
progressMode="NONE"> 
           <columns> 
               <column attribute="com.ibm.team.apt.attribute.summary" 
width="100"> 
                   <parameters> 
                       <parameter key="SMALL" value="true"/> 
                       <parameter key="MEDIUM" value="true"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column> 
               <column attribute="com.ibm.team.apt.attribute.owner" 
width="0"> 
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                   <parameters> 
                       <parameter key="SMALL" value="true"/> 
                       <parameter key="MEDIUM" value="true"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column> 
               <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.wsjf" width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="true"/> 
                       <parameter key="MEDIUM" value="true"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column> 
               <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.jobSize" width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="false"/> 
                       <parameter key="MEDIUM" value="false"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column>           
               <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.ubVal" width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="false"/> 
                       <parameter key="MEDIUM" value="false"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column> 
               <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.timeCrit" width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="false"/> 
                       <parameter key="MEDIUM" value="false"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column>           
               <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.rroe" width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="false"/> 
                       <parameter key="MEDIUM" value="false"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column> 
               <column 
attribute="planning/source/com.ibm.team.workitem.linktype.parentworkitem" width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="false"/> 
                       <parameter key="MEDIUM" value="true"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column>                
               <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.apt.attribute.planitem.blocked" 
width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="true"/> 
                       <parameter key="MEDIUM" value="true"/> 
                       <parameter key="LARGE" value="true"/> 
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                   </parameters> 
               </column>  
           </columns> 
           <viewmode 
definition="com.ibm.team.apt.internal.viewmode.kanban"> 
               <parameters> 
                <parameter key="State Group &lt;open&gt;" value="true"/> 
                <parameter key="State Group &lt;review&gt;" value="true"/> 
                <parameter key="State Group &lt;inprogress&gt;" 
value="true"/> 
                <parameter key="State Group &lt;invalid&gt;" 
value="true"/> 
                <parameter key="State Group &lt;done&gt;" value="true"/> 
                   <parameter key="analysis-Approved" value="true"/> 
                   <parameter key="closed-Closed" value="true"/>  
                                   
             <parameter key="kanban-config" 
value="{&quot;analysis&quot;:10}"/> 
               </parameters> 
           </viewmode> 
 
           <groupmode definition="com.ibm.team.apt.groupmode.none"/> 
           <sortmode definition="com.ibm.team.apt.sortmode.wsjf"/> 
           <filters> 
      <filter 
definition="com.ibm.team.apt.filter.excludeNonCapabilities"/> 
     </filters> 
       </planmode> 
        
    <planmode 
id="com.ibm.team.apt.viewmodes.internal.valueStreamRoadmap" name="Roadmap" 
progressMode="NONE"> 
     <viewmode 
definition="com.ibm.team.apt.internal.viewmode.tree" /> 
     <groupmode definition="com.ibm.team.apt.groupmode.none"/> 
     <sortmode definition="com.ibm.team.apt.sortmode.wsjf"/> 
     <filters> 
      <filter 
definition="com.ibm.team.apt.filter.resolved"/> 
     </filters> 
     <columns> 
      <column 
attribute="com.ibm.team.apt.attribute.planitem.id" /> 
      <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.wsjf" /> 
      <column 
attribute="com.ibm.team.apt.attribute.planitem.ownedBy" /> 
      <column 
attribute="com.ibm.team.apt.attribute.planitem.state" /> 
      <column 
attribute="com.ibm.team.apt.attribute.planitem.plannedFor" /> 
     </columns> 
    </planmode> 
    <planmode 
id="com.ibm.team.apt.viewmodes.internal.valueStreamWSJFRankedList" name="WSJF Ranked List" 
progressMode="NONE"> 
     <viewmode 
definition="com.ibm.team.apt.internal.viewmode.backlog" /> 
     <groupmode definition="com.ibm.team.apt.groupmode.none"/> 
     <sortmode definition="com.ibm.team.apt.sortmode.wsjf"/> 
     <filters> 
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      <filter 
definition="com.ibm.team.apt.filter.resolved"/> 
      <filter 
definition="com.ibm.team.apt.filter.excludeNonCapabilities"/> 
     </filters> 
     <columns> 
      <column 
attribute="com.ibm.team.apt.attribute.planitem.id" /> 
      <column 
attribute="com.ibm.team.apt.attribute.planitem.state" /> 
      <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.wsjf" /> 
      <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.jobSize" /> 
      <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.ubVal"/> 
      <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.timeCrit"/> 
      <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.rroe"/> 
     </columns> 
    </planmode> 
 

23. Finally, update all of the plan views that currently display the WSJF (integer) attribute so that they 

now show the new decimal version of that attribute. In the Process Configuration Source, find and 

replace all instances of:  

<column attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.wsjf" 

with  

<column attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.wsjfDecimal" 

24. Save your changes.  

PLAN FILTERS 

In this section, we add the filters required by the plan models.  

1. Search for <configuration-data final="false" 

id="com.ibm.team.apt.configuration.planConfigurationElement": 

 

Note: Your groupmode id may not be the same. 

2. Add a new set of <filter> sections for the excludeNonPortfolioEpics, excludeNonCapabilities and 

excludeNonValueStreamEpics filters by copying and pasting this entire section into the 

planConfigurationElement section (at the top or the bottom, doesn’t matter):   

       <filter description="Exclude all work item types except portfolio 
epics." id="com.ibm.team.apt.filter.excludeNonPortfolioEpics" 
implementation="com.ibm.team.apt.shared.ui.internal.filter.WorkItemTypeFilter" name="All 
except portfolio epics"> 
     <parameters> 
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      <parameter key="include-types" 
value="com.ibm.team.workitem.workItemType.portfolioEpic"/> 
     </parameters> 
    </filter> 
        
       <filter description="Exclude all work item types except 
capabilities." id="com.ibm.team.apt.filter.excludeNonCapabilities" 
implementation="com.ibm.team.apt.shared.ui.internal.filter.WorkItemTypeFilter" name="All 
except capabilities"> 
     <parameters> 
      <parameter key="include-types" 
value="com.ibm.team.workitem.workItemType.capability"/> 
     </parameters> 
    </filter> 
    <filter description="Exclude all work item types except value 
stream epics." id="com.ibm.team.apt.filter.excludeNonValueStreamEpics" 
implementation="com.ibm.team.apt.shared.ui.internal.filter.WorkItemTypeFilter" name="All 
except value stream epics"> 
     <parameters> Team 1 (rename) 
      <parameter key="include-types" 
value="com.ibm.team.workitem.workItemType.valueStreamEpic"/> 
     </parameters> 
    </filter>  

3. Save your changes.   

4. Finally, resolve a potential issue with the Ranking Attribute. Search for <attribute 
id="com.ibm.team.apt.attribute.planitem.ranking":  

 

5. If you see the error (as above), replace this entire section by copy-pasting the following:  

       <attribute id="com.ibm.team.apt.attribute.planitem.ranking" 
implementation="com.ibm.team.apt.shared.client.RankingAttribute" internal="false" 
name="User/Business Value" readOnly="false" type="RANKING"> 
           <parameters> 
               <parameter key="attribute" 
value="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.ubVal"/> 
           </parameters> 
       </attribute> 

6. Save your changes.  
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DASHBOARD 

UPDATE SAFE V4.0 PROGRAM PROCESS TEMPLATE 

PLANS 

In this section, we update the Program Kanban plan view and add new Feature Kanban plan view. 

1. In the My SAFe V4.0 Program Process, click on the Process Configuration Source tab. 

2. Locate the existing XML section:  

<followup-action xmlns="http://com.ibm.team.apt/setUpProject" description="Initializes the project 
area with the plans." id="com.ibm.team.apt.service.setUpProject" name="Set Up Project for Plans"> 

 
3. Replace this entire <plans> section within that <followup-action> with this XML:  
 
<plans> 
<plan iterationPath="/program-timeline/roadmap/backlog" name="Program Name (rename) Backlog" 
typeId="com.ibm.team.apt.plantype.programBacklog"/> 
<plan iterationPath="/program-timeline/roadmap/backlog" name="Team 1 (rename) Backlog" ownerPath="Team 1 
(rename)" typeId="com.ibm.team.apt.plantype.product.backlog"/> 
<plan iterationPath="/program-timeline/roadmap/backlog" name="Team 2 (rename) Backlog" ownerPath="Team 2 
(rename)" typeId="com.ibm.team.apt.plantype.product.backlog"/> 
<plan iterationPath="/program-timeline/roadmap" name="Program Name (rename) Roadmap" 
typeId="com.ibm.team.apt.plantype.programBacklog"/> 
<plan iterationPath="/program-timeline/roadmap/art/pi1" name="Program Name (rename) PI 1" 
typeId="com.ibm.team.apt.plantype.programBacklog"/> 
<plan iterationPath="/program-timeline/roadmap/art/pi1/pi1-s1.1" name="Team 1 (rename) Sprint 1.1" 
ownerPath="Team 1 (rename)" typeId="com.ibm.team.apt.plantype.default"/> 
<plan iterationPath="/program-timeline/roadmap/art/pi1/pi1-s1.1" name="Team 2 (rename) Sprint 1.1" 
ownerPath="Team 2 (rename)" typeId="com.ibm.team.apt.plantype.default"/> 
<plan iterationPath="/program-timeline/roadmap/art/pi1/pi1-s1.2" name="Team 1 (rename) Sprint 1.2" 
ownerPath="Team 1 (rename)" typeId="com.ibm.team.apt.plantype.default"/> 
<plan iterationPath="/program-timeline/roadmap/art/pi1/pi1-s1.2" name="Team 2 (rename) Sprint 1.2" 
ownerPath="Team 2 (rename)" typeId="com.ibm.team.apt.plantype.default"/> 
<plan iterationPath="/program-timeline/roadmap/art/pi1/pi1-s1.3" name="Team 1 (rename) Sprint 1.3" 
ownerPath="Team 1 (rename)" typeId="com.ibm.team.apt.plantype.default"/> 
<plan iterationPath="/program-timeline/roadmap/art/pi1/pi1-s1.3" name="Team 2 (rename) Sprint 1.3" 
ownerPath="Team 2 (rename)" typeId="com.ibm.team.apt.plantype.default"/> 
</plans> 

 

4. Search for <plantype id="com.ibm.team.apt.plantype.programBacklog":  

 

5. Add a new <planmode> section for the Feature Kanban Board plan view by copy-pasting the 

following into the <planmodes> section for the programKanbanBoard 

Note: In the following sections, you will be copying and pasting XML source into the Process 

Configuration Source. Unless otherwise indicated, you can paste that source at the end of any 

section, taking care to ensure that the formatting is correct and no XML errors are introduced.  
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<planmode definition="com.ibm.team.apt.viewmodes.internal.featureKanbanBoard"/>  
 

6. Search for <planmode id="com.ibm.team.apt.viewmodes.internal.programKanbanBoard":  

 

 
7. Change the name of this view to Program Kanban View:  

<planmode id="com.ibm.team.apt.viewmodes.internal.programKanbanBoard" name="Program Kanban 
View" progressMode="NONE"> 

 
8. Scroll down to the <viewmode> section and copy-paste the following to replace that entire section:  

<viewmode definition="com.ibm.team.apt.internal.viewmode.kanban"> 
               <parameters> 
                <parameter key="State Group &lt;open&gt;" value="true"/> 
                <parameter key="State Group &lt;backlog&gt;" 
value="true"/> 
                <parameter key="State Group &lt;inprogress&gt;" 
value="true"/> 
                <parameter key="State Group &lt;invalid&gt;" 
value="true"/> 
                <parameter key="State Group &lt;done&gt;" value="true"/> 
                <parameter key="State Group &lt;implementation&gt;" 
value="true"/> 
                   <parameter key="closed-Closed" value="true"/>  
                                   
             <parameter key="kanban-config" 
value="{&quot;review&quot;:10,&quot;analysis&quot;:5}"/> 
               </parameters> 
           </viewmode> 
 

9. Search for <planmode id="com.ibm.team.apt.viewmodes.internal.programRoadmap":  

 

 
10. Update the columns shown in the Program Roadmap report by copy-pasting the following section to 

replace the <columns> section:  
     <columns> 
      <column 
attribute="com.ibm.team.apt.attribute.planitem.id" width="10"/> 
      <column 
attribute="com.ibm.team.apt.attribute.owner" width="15"/> 
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      <column 
attribute="com.ibm.team.apt.attribute.planitem.state" width="10"/> 
      <column 
attribute="com.ibm.team.apt.attribute.planitem.plannedFor" width="15"/> 
      <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.wsjf" width="10" /> 
      <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.jobSize" width="10" /> 
      <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.ubVal" width="10" /> 
      <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.timeCrit" width="10" 
/> 
      <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.rroe" width="10"/> 
      <column 
attribute="planning/source/com.ibm.team.workitem.linktype.trackedworkitem/trackedBy" 
width="10" /> 

     </columns> 
 

 
11. Add a new <planmode> for the Feature Kanban plan view by copy-pasting this entire section (after 

the “Architectural Runway” plan mode is fine):  
    <planmode 
id="com.ibm.team.apt.viewmodes.internal.featureKanbanBoard" name="Feature Kanban View" 
progressMode="NONE"> 
           <columns> 
               <column attribute="com.ibm.team.apt.attribute.summary" 
width="100"> 
                   <parameters> 
                       <parameter key="SMALL" value="true"/> 
                       <parameter key="MEDIUM" value="true"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column> 
               <column attribute="com.ibm.team.apt.attribute.owner" 
width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="true"/> 
                       <parameter key="MEDIUM" value="true"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column> 
               <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.wsjf" width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="true"/> 
                       <parameter key="MEDIUM" value="true"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column> 
               <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.jobSize" width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="false"/> 
                       <parameter key="MEDIUM" value="false"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column>           
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               <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.ubVal" width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="false"/> 
                       <parameter key="MEDIUM" value="false"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column> 
               <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.timeCrit" width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="false"/> 
                       <parameter key="MEDIUM" value="false"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column>           
               <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.rroe" width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="false"/> 
                       <parameter key="MEDIUM" value="false"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column> 
               <column 
attribute="planning/source/com.ibm.team.workitem.linktype.parentworkitem" width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="false"/> 
                       <parameter key="MEDIUM" value="true"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column>                
               <column 
attribute="com.ibm.team.apt.attributes._com.ibm.team.apt.attribute.planitem.blocked" 
width="0"> 
                   <parameters> 
                       <parameter key="SMALL" value="true"/> 
                       <parameter key="MEDIUM" value="true"/> 
                       <parameter key="LARGE" value="true"/> 
                   </parameters> 
               </column>  
           </columns> 
           <viewmode 
definition="com.ibm.team.apt.internal.viewmode.kanban"> 
               <parameters> 
                <parameter key="State Group &lt;open&gt;" value="true"/> 
                <parameter key="State Group &lt;review&gt;" value="true"/> 
                <parameter key="State Group &lt;inprogress&gt;" 
value="true"/> 
                <parameter key="State Group &lt;invalid&gt;" 
value="true"/> 
                <parameter key="State Group &lt;done&gt;" value="true"/> 
                   <parameter key="analysis-Approved" value="true"/> 
                   <parameter key="closed-Closed" value="true"/>  
                                   
             <parameter key="kanban-config" 
value="{&quot;analysis&quot;:10}"/> 
               </parameters> 
           </viewmode> 
 
           <groupmode definition="com.ibm.team.apt.groupmode.none"/> 
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           <sortmode definition="com.ibm.team.apt.sortmode.wsjf"/> 
           <filters> 
      <filter 
definition="com.ibm.team.apt.filter.excludeNonFeatures"/> 
     </filters> 
       </planmode>       

12. Save your changes.  
13. Finally, resolve a potential issue with the Ranking Attribute. Search for <attribute 

id="com.ibm.team.apt.attribute.planitem.ranking":  

 

14. If you see the error (as above), replace this entire section by copy-pasting the following:  

       <attribute id="com.ibm.team.apt.attribute.planitem.ranking" 
implementation="com.ibm.team.apt.shared.client.RankingAttribute" internal="false" 
name="User/Business Value" readOnly="false" type="RANKING"> 
           <parameters> 
               <parameter key="attribute" 
value="com.ibm.team.apt.attributes._com.ibm.team.workitem.attribute.ubVal"/> 
           </parameters> 
       </attribute> 

15. Save your changes.  

DASHBOARD 

 
Yay! 

You 

did 

it! 

You 

now have “master” project areas for SAFe V4.0 Portfolio and Program or your own customized process 

templates. You can export your new templates in the Application Administration > Templates section of 

the browser. Have at it!  

Note: In the following sections, you will be copying and pasting XML source into the Process 

Configuration Source. Unless otherwise indicated, you can paste that source at the end of any 

section, taking care to ensure that the formatting is correct and no XML errors are introduced.  
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RATIONAL DOORS NEXT GENERATION SAFE V4.0 TEMPLATE 
CONFIGURATION 
To configure an RDNG project area that supports SAFe V4.0, you start by configuring a project area 

based on the SAFe V3.0 project template. You then will apply changes as documented in this section and 

save your new project template that can be used for new RDNG project areas for the SAFe V4.0 

portfolio.  

1. Launch RDNG in your browser and logon on as an administrator. Navigate to the All Projects view.  

2. Select Create Project Area from the Administration drop-down menu option:  

 

3. In the New Project wizard, specify a name: My SAFe V4.0 Portfolio. Click Next.  

 

4. Click Use a template to initially populate the project and select the SAFe Portfolio Project 

Template. Click Finish.   
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5. Repeat the steps above to create a new project area based on the Agile Requirements project 

template:  

Name: Agile Project (with data), Template: Agile Requirements Sample 

You will harvest new artifacts for your SAFe V4.0 project template from these templates.  

6. On your dashboard, you should see all of the project areas you’ve created in the My Requirements 

Projects widget:  

 

FOLDERS 
In this section, you update the folder structure to provide a place to store the artifact templates.  

1. Click on the Create or show artifacts link next to My SAFe V4.0 Portfolio in the My Requirements 

Projects widget to launch the artifact browser.  

1. In the Filter by Folder pane on the left, select the My SAFe V4.0 Portfolio, right-click and select 

Create Folder… :  



Configuring SAFe V4.0 in CLM 193 8/17/2016 

 

2. Provide the folder Name: SAFe Artifact Templates 

 

Click OK. 

3. Select the SAFe Terms folder, right-click and select Delete Folder… : 

 

4. Check the Delete the folder and all its contents, including child folders checkbox, then click Delete: 

 

5. Expand the SAFe Artifacts folder, then right-click on the Templates folder and select Delete Folder… 

, confirming that you want to delete the folder and all of its contents:  

 

 

6. Select Value Streams and right-click to Create Folder… : 
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7. Specify the Name: Value Stream 1 (rename)  

 

8. Create another folder within the Value Stream folder with Name: Value Stream 2 

(rename). These will serve as placeholders as you add Value Streams and associated artifacts. 

Your new folder structure should look like this:  

 

 

IMPORT ARTIFACTS 
Before configuring the SAFe RDNG project template, import artifacts from the Agile Project (with data) 

project area. You will end up with some extraneous configuration artifacts, but we want to harvest some 

key artifacts for SAFe.  

1. Select Manage Project Properties from the Administration drop-down menu:  

 

2. In the menu bar, select Import:  

 

3. In the Import Project Properties dialog, click the Browse… button and select Agile Project (with 

data):  
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4. Click Next. The Review Property Changes page shows the set of things that will be changed when 

you complete the import. Click Finish and then Close. 

 

ATTRIBUTES 
In this section, you will change the data type for some attributes. In order to do this, you actually must 

delete and recreate them. First, you must remove them from existing artifacts.  

1. Select Artifact Types from the menu bar:  
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2. Navigate to the [SAFe] Strategic Theme artifact and select it for editing. In the Artifact Attributes 

box, select Allocated Invesment and Budgeted Capacity and click X Remove Attribute:  

 

3. Click Yes to confirm the deletion. Save your changes.  

 

4. Select Attribute Types from the menu bar:  

 

5. In the Artifact Attributes box, navigate to the Allocated Investment attribute and then use the pencil 

icon to select Delete 

 

6. Click Yes to confirm the deletion. Save your changes. Repeat this process to delete the Budgeted 

Capacity attribute.  

7. Click + New Attribute… on the top right of the Artifact Attributes  box to add new attributes: 
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ALLOCATED INVESTMENT 

Name: Allocated Investment 

Description: Sum of estimated investment for all work completed, in 
progress of planned for this strategic theme as roll up from 

Portfolio Epics. Only *approved* Epics are included in the roll-up. 

Data Type: Float 

BUDGETED CAPACITY 

Name: Budgeted Capacity 

Description: Capacity (in standard unit of measure, for example Dev PM) 
available to a Value Stream or Program for the current budget cycle. 

Data Type: Float 

8. Save your changes.  

 

LINK TYPES 
1. Select Link Types from the menu bar:  

 

2. Click + Add… on the top right of the Link Types  box to add new link types:  

REALIZES 

Name: Realizes 

Description: SAFe link type to indicate that that Strategic Themes are 
realized by Value Streams. 

Provide directional labels for the relationship: <checked> 

A to B: Realizes 

B to A: Realized By 

INFORMS 

Name: Informs 

Description: SAFe link type to indicate that Solution Intent and 
Solution Context inform each other. 

Note: In this section, you will be setting up “preferred link types”, which include the OSLC 

link types, such as “Implemented By”. You may not have these types available if you have 

not associated your RDNG project area with RTC and RQM projects (such as by creating a 

CLM Lifecycle Project Area). This does not cause a problem ultimately; preferred link types 

are merely a convenience.  
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Provide directional labels for the relationship: <checked> 

A to B: Informs 

B to A: Informs 

3. Your Link Types table now shows these new SAFe link types:  

 

UPDATE EXISTING ARTIFACT TYPES 
In this section, you will update existing artifact types that are already in your project area.  

 

STRATEGIC THEME 
1. Select Artifact Types from the menu bar:  

 

1. In the Artifact Types pane, select [SAFe] Strategic Theme: 

 

2. Click the Change… button next to Icon to change the icon to something other than the Vision icon 

(which will be used in the Vision artifact later). For example, we use Design Brief:  

 

3. Select the Choose… button next to Preferred link types: and select Realized By (leave Implemented 

By selected):  
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4. Click OK. Your updated Strategic Theme looks like this:  

 

5. In the Artifact Attributes  pane, select the Allocated Capacity attribute and click X Remove 

Attribute…:  

 

6. Click Yes to confirm the deletion:  
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7. Repeat this procedure to remove Budgeted Investment and Total Market Opportunity. The 

remaining attributes list should look like this:  

 

8. Click Save to save your changes.  

VALUE STREAM 
1. In the Artifact Types pane, select [SAFe] Value Stream: 

 

2. Click the Change… button next to Icon to change the icon to something other than the Set icon 

(which is used in the Collection artifact later). For example, we use Customer Input:  

 

3. Select the Choose… button next to Preferred link types: and add Satisfied By (leave Implemented By 

selected):   
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4. Click OK. Your updated Value Stream looks like this:  

 

5. In the Artifact Attributes  pane, select + Add Attribute… and then click the checkbox next to 

Allocated Capacity, Allocated Investment, Budgeted Capacity, Budgeted Investment, Status, and 

Total Market Opportunity :  

 

Note that you will need to scroll down to select the additional attributes.  

6. Click OK.  Select Owner to move it down just above Status using the  down arrow:  

 

7. Select Total Market Opportunity and move it above Owner. 

8. The resulting set of attributes should look like this:  
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9. Click Save to save your changes.  

LIGHTWEIGHT BUSINESS CASE 
1. In the Artifact Types pane, select [SAFe] Lightweight Business Case: 

 

2. In the Artifact Attributes  pane, Select Owner to move it down just above Status using the  

down arrow:  

 

3. The resulting set of attributes should look like this:  

 

4. Click Save to save your changes.  
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ROLE 
1. In the Artifact Types pane, select Role: 

 

2. Ensure the Use artifacts of this type as glossary terms checkbox is selected in the Artifact roles: 

section:  

 

3. In the Artifact Attributes  pane, select + Add Attribute… and then click the checkbox next to Owner 

and Status:  

 

4. Click OK.  The resulting set of attributes should look like this:  

 

5. Click Save to save your changes.  

TERM 
1. In the Artifact Types pane, select Term: 
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2. Ensure the Use artifacts of this type as glossary terms checkbox is selected in the Artifact roles: 

section:  

 

3. In the Artifact Attributes  pane, select + Add Attribute… and then click the checkbox next to Origin:  

 

4. Click OK.  The resulting set of attributes should look like this:  

 

5. Click Save to save your changes. 

VISION 
1. In the Artifact Types pane, select Vision: 
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2. Change these details:  

Name: [SAFe] Vision 

Description: In SAFe, the Vision describes a future view of a solution 
or end-user capability to be developed, providing the larger, 

contextual overview and purpose.  

Preferred link types: Satisfies, Satisfied By, Embedded In, Illustrated By 

3. Your updated Vision looks like this:  

 

4. In the Artifact Attributes  pane, select + Add Attribute… and then click the checkbox next to Owner:  
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5. Click OK, then select the Product Owner attribute and click X Remove Attribute…:  

 

 

6. Click Yes to confirm the deletion.  

7. In the Artifact Attributes  pane, Select Status to move it down just below Owner using the  

down arrow. 

8. The resulting set of attributes should look like this:  

 
9. Click Save to save your changes.  

LIFECYCLE SCENARIO 
1. In the Artifact Types pane, select Lifecycle Scenario: 



Configuring SAFe V4.0 in CLM 207 8/17/2016 

 

2. Change these details:  

Name: [SAFe] Lifecycle Scenario 

Icon:  

Description: The Lifecycle Scenario illustrates the Vision by providing 
and end-to-end usage model for a solution. This artifact would be 

created during the Analysis phase of the Kanban for Epics.  

Default artifact format: Text 

Preferred link types: Illustrates 

3. Your updated Lifecycle Scenario looks like this:  

 

4. In the Artifact Attributes  pane, select + Add Attribute… and then click the checkbox next to Owner:  
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5. Click OK, then select the Artifact Owner and Scenario Publish Date attributes and click X Remove 

Attribute…:  

 

6. Click Yes to confirm the deletion.  

7. In the Artifact Attributes  pane, Select Status to move it down just below Owner using the  

down arrow. 

8. The resulting set of attributes should look like this:  

 
9. Click Save to save your changes.  

SCENARIO ACT 
1. In the Artifact Types pane, select Scenario Act: 

 



Configuring SAFe V4.0 in CLM 209 8/17/2016 

2. Change these details:  

Name: [SAFe] Scenario Act 

Description: The Scenario Act is a child of the Lifecycle Scenario and 
elaborates a Use Case that is part of the end-to-end scenario. There 

may be multiple Acts in a Lifecycle Scenario. Capabilities and 

Features might implement the Act.  

Preferred link types: Child of 

3. Your updated Scenario Act looks like this:  

 

4. In the Artifact Attributes  pane, select + Add Attribute… and then click the checkbox next to Owner:  

 

5. Click OK, then select the Artifact Owner, Scenario Applications, Scenario Persona and Scenario Roles 

attributes and click X Remove Attribute…:  
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This information will be part of the Scenario Act template.  

6. Click Yes to confirm the deletion.  

7. In the Artifact Attributes  pane, Select Status to move it down just below Owner using the  

down arrow. 

8. The resulting set of attributes should look like this:  

 
9. Click Save to save your changes.  

SCENARIO SCENE 
1. In the Artifact Types pane, select Scenario Scene: 

 

2. Change these details:  

Name: [SAFe] Scenario Scene 

Description: The Scenario Scene is a child of the Scenario Act. A Scene 
is a single-role activity that is part of an Act. Scenes might be 

implemented by Features or Stories.  

Preferred link types: Child of 

3. Your updated Scenario Scene looks like this:  
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4. In the Artifact Attributes  pane, select + Add Attribute… and then click the checkbox next to Owner:  

 

5. Click OK, then select the Artifact Owner, Scenario Applications, Scene Type, Scenario Persona and 

Scenario Roles attributes and click X Remove Attribute…:  

 

This information will be part of the Scenario Scene template.  

6. Click Yes to confirm the deletion. 
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7. In the Artifact Attributes  pane, Select Status to move it down just below Owner using the  

down arrow. 

8. The resulting set of attributes should look like this:  

 
9. Click Save to save your changes.  

NON-FUNCTIONAL REQUIREMENT 
1. In the Artifact Types pane, select Non Functional: 

 

2. Change these details:  

Name: Non-Functional Requirement 

Description: The Non-Functional Requirement (NFR) describes system 
attributes such as security, reliability, maintainability, 

scalability and usability (i.e. “ilities”).  

Preferred link types: Satisfies, Constrains 

3. Your updated Non-Functional Requirement looks like this:  

 

4. In the Artifact Attributes  pane, select + Add Attribute… and then click the checkbox next to Owner:  
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5. Click OK, then select the Difficulty and click X Remove Attribute…:  

 

6. Click Yes to confirm the deletion. 

7. Use the up and down arrows to order the attributes as indicated below: 

 

8. Click Save to save your changes.  

WIREFRAME 
1. In the Artifact Types pane, select Storyboard Frame: 
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2. Change these details:  

Name: Wireframe 

Description: The wireframe further illustrates a Lifecycle Scenario and 
informs implementation of a Capability, Feature or Story.  

Preferred link types: Illustrates 

3. Your updated Wireframe looks like this:  

 

4. In the Artifact Attributes  pane, select + Add Attribute… and then click the checkbox next to Owner, 

Priority, and Status:  
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5. Use the up and down arrows to order the attributes as indicated below:  

 

6. Click Save to save your changes.  

COLLECTION 
1. In the Artifact Types pane, select Collection: 

 

2. In the Artifact Attributes  pane, select + Add Attribute… and then click the checkbox next to Owner:  

 

3. Click OK, then select the Artifact Set Type and Product Owner attributes and click X Remove 

Attribute…:  

 

4. Click Yes to confirm the deletions. 

5. Use the up and down arrows to order the attributes as indicated below: 
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6. Click Save to save your changes.  

CREATE NEW ARTIFACT TYPES 
In this section, you will create new artifact types required for support of SAFe V4.0.   

PROGRAM 
1. In the Artifact Types box, click + New Type… to create a new Program artifact type.  

 

2. Specify these details:  

Name: [SAFe] Program 

Icon: System Requirement Module 

Description: This artifact is prescribed by SAFe to define a long-lived 
self-governing system that plans and manages change to deliver value 

aligned with business strategy. Programs (Agile Release Trains) 

realize Value Streams. They are where development teams and other 

resources are applied to important ongoing work efforts.   

Default artifact format: Text 

Preferred link types: Realizes, Implemented By 

 

3. In the Artifact Attributes  pane, select + Add Attribute… and then click the checkbox next to 

Allocated Capacity, Allocated Investment, Budgeted Capacity, Budgeted Investment, Owner and 

Status.  

4. Click OK.  The resulting set of attributes should look like this:  
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5. Click Save to save your changes.  

SOLUTION INTENT 
1. In the Artifact Types box, click + New Type… to create a new Solution Intent artifact type.  

 

2. Specify these details:  

Name: [SAFe] Solution Intent 

Icon:  

Description: In SAFe, the Solution Intent provides the basic 
understanding of the current and evolving requirements, design, and 

intent -- or larger purpose -- of the Solution.   

Default artifact format: Text 

Preferred link types: Embeds, Informs 
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3. In the Artifact Attributes  pane, select + Add Attribute… and then click the checkbox next to Owner 

and Status:  

 

4. Click OK.  The resulting set of attributes should look like this:  

 
5. Click Save to save your changes.  

SOLUTION CONTEXT 
1. In the Artifact Types box, click + New Type… to create a new Solution Context artifact type.  

 

2. Specify these details:   
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Name: [SAFe] Solution Context 

Icon:  

Description: In SAFe, the Solution Context identifies those critical 
aspects of the target solution environment including usage, 

installation, deployment, run time and support.    

Default artifact format: Text 

Preferred link types: Informs 

 

3. In the Artifact Attributes  pane, select + Add Attribute… and then click the checkbox next to Owner 

and Status:  

 

4. Click OK.  The resulting set of attributes should look like this:  

 
5. Click Save to save your changes.  

STANDARD 
1. In the Artifact Types box, click + New Type… to create a new Standard artifact type.  
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2. Specify these details:  

Name: Standard 

Icon:  

Description: A Standard is a specific type of requirement that defines a 
regulatory or system constraint.     

Default artifact format: Text 

Preferred link types: Satisfied By 

 

3. In the Artifact Attributes  pane, select + Add Attribute… and then click the checkbox next to Origin, 

Owner, Priority, Stability and Status:  

 

 

4. Use the up and down arrows to order the attributes as indicated below: 

 

5. Click Save to save your changes.  
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USER REQUIREMENT 
1. In the Artifact Types box, click + New Type… to create a new User Requirement artifact type.  

 

2. Specify these details:  

Name: User Requirement 

Icon:  

Description: A User Requirement specifically describes a capability 
required by end-users or customers. User Requirements are typically 

implemented by Features or Stories.     

Default artifact format: Text 

Preferred link types: Constrained By, Child Of, Satisfies 

 

3. In the Artifact Attributes  pane, select + Add Attribute… and then click the checkbox next to Owner, 

Priority, and Status:  

 

 

4. Use the up and down arrows to order the attributes as indicated below: 
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5. Click Save to save your changes.  

SYSTEM REQUIREMENT 
1. In the Artifact Types box, click + New Type… to create a new System Requirement artifact type.  

 

2. Specify these details:  

Name: System Requirement 

Icon:  

Description: A System Requirement specifically describes architectural, 
operational, or other details necessary to support the delivery of 

capabilities.      

Default artifact format: Text 

Preferred link types: Constrained By, Satisfies 

 

3. In the Artifact Attributes  pane, select + Add Attribute… and then click the checkbox next to Owner, 

Priority, Status, Stability, and Origin:  
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4. Use the up and down arrows to order the attributes as indicated below: 

 

5. Click Save to save your changes.  

CLEAN UP 
This section is optional. If you would prefer to have a “clean” SAFe V4.0 requirements project template, 

you can follow these steps to remove the extraneous artifact types and tags. 

1. In the Artifact Types box, select Business Goal, right-click and then select X Delete in the context 

menu:  

 

2. Select Yes to confirm the deletion:  

 

3. Repeat steps 1-2 to remove the following artifact types:  

 Business Process Diagram 

 Business Rule 

 Feature 

 Information 

 Persona 
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 Process Guidance 

 Program Increment Collection 

 Software Requirement Specification 

 Storyboard 

 Supporting Doc 

 User Story Elaboration 

4. Click Artifacts > Browse Artifacts option from the menu bar:  

 

5. Click on the Filter by Tag option: 

 

6. Remove the following shared tags by right-clicking each one and selecting X Delete  

 analytics 

 competitive_advantage 

 mainframe 

 reporting 

7. Confirm the deletion of each tag:  

 

CREATE ARTIFACT TEMPLATES 
In this section, you create new artifact templates for:  

 Value Stream 

 Vision 

 Solution Intent 

 Solution Context 

 Lifecycle Scenario 

 Scenario Act 

 Scenario Scene 
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Before creating these new templates, create the [SAFe] template artifacts for Strategic Theme and 

Lightweight Business Case that already exist in our project area and store them in the new SAFe Artifact 

Templates folder.  

LIGHTWEIGHT BUSINESS CASE 
1. Click Artifacts > Browse Artifacts option from the menu bar:  

 

2. Create a new [SAFe] Lightweight Business Case template based on the template, specifying the 

following details:  

Name: [SAFe] Lightweight Business Case Template 

Template: [SAFe] Lightweight Business Case Template 

Folder: SAFe Artifact Templates 

Open artifact: <unchecked> 
 

  

3. Click OK. 

STRATEGIC THEME 
4. Repeat the procedure used to create the Lightweight Business Case to create a new [SAFe] Strategic 

Theme template based on the template, specifying the following details:  

Name: [SAFe] Strategic Theme Template 

Template: [SAFe] Strategic Theme Template 

Folder: SAFe Artifact Templates 

Open artifact: <unchecked> 
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5. Click OK.  

6. Select the SAFe Artifact Templates folder. The contents should look like this:  

 

VALUE STREAM TEMPLATE 
1. Select the drop-down arrow to create a new [SAFe] Value Stream artifact:  

 

Note: If you do not see the artifact type in the list, you need to click More… and then specify the 

type in the Create Artifact dialog box: 
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2. Specify these details:  

Name: [SAFe] Value Stream Template 

Template: None 

Open artifact: <checked> 

 

3. Copy and paste the following text into your new artifact:  

[Value Stream Title] 

Summary 

<Describe the Value Stream in terms of the capabilities and value to the business and to customers.  

Example: Provides customers with a fast, consistent banking experience online or via mobile devices. <remove> 

Customer(s) 

<Describe the customers that use capabilities provided by this Value Stream.> 

Example: Personal banking customers, small business owners. <remove> 
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Triggers 

<Describe the customer activities that trigger usage of the capabilities delivered by this Value Stream.> 

Example: Open a new bank account, transfer money, check balances, check recent activity, bill pay, budget management, 

initiate loans, plan for retirement. <remove> 

Inputs 

<Describe the inputs involved in the trigger activities.> 

Example: New bank account (with customer information), logon to existing accounts (with customer information), new loan. 
<remove> 

Outputs 

<Describe the outputs involved in the trigger activities.> 

Example: Account opened, money transferred or deposited, bills paid. <remove> 

Includes 

<Describe the products, subsystems, applications or components that are included in this Value Stream.> 

Example: Bank Account Management, Retirement Planning, Loan Management.<remove> 

4. Click Done:  

 

5. Click SAFe Artifact Templates in the breadcrumb trail at the top of your artifact to return to that 

folder:  

 

PROGRAM TEMPLATE 
1. Select the drop-down arrow to create a new [SAFe] Program artifact:  
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Note: If you do not see the artifact type in the list, you need to click More… and then specify the 

type in the Create Artifact dialog box: 

 

2. Specify these details:  

Name: [SAFe] Program Template 

Template: None 

Open artifact: <checked> 
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3. Copy and paste the following text into your new artifact:  

[Program Title] 

Summary 

<Describe the Program in terms of the capabilities and value to the business and to customers.  

Example: Provides customers with a fast, consistent banking experience online or via mobile devices. <remove> 

Customer(s) 

<Describe the customers that use capabilities provided by this Program.> 

Example: Personal banking customers, small business owners. <remove> 

Triggers 

<Describe the customer activities that trigger usage of the capabilities delivered by this Program.> 

Example: Open a new bank account, transfer money, check balances, check recent activity, bill pay, budget management, 
initiate loans, plan for retirement. <remove> 

Inputs 
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<Describe the inputs involved in the trigger activities.> 

Example: New bank account (with customer information), logon to existing accounts (with customer information), new loan. 
<remove> 

Outputs 

<Describe the outputs involved in the trigger activities.> 

Example: Account opened, money transferred or deposited, bills paid. <remove> 

Includes 

<Describe the products, subsystems, applications or components that are included in this Program.> 

Example: Bank Account Management, Retirement Planning, Loan Management.<remove> 

4. Click Done:  

 

5. Click SAFe Artifact Templates in the breadcrumb trail at the top of your artifact to return to that 

folder:  

 

VISION TEMPLATE 
1. Select the drop-down arrow to create a new [SAFe] Vision artifact template:  

 

Note: If you do not see the artifact type in the list, you need to click More… and then specify the 

type in the Create Artifact dialog box: 
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2. Specify these details:  

Name: [SAFe] Vision Template 

Template: None 

Open artifact: <checked> 

 

3. Copy and paste the following text into your new artifact:  

[Vision Title] 

Northstar 

<We need to...> 

Context Diagram 

<Draw a picture with the solution as a black box showing all of the human (HMI) and machine (API) 

interfaces> 

Key Elements 
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<What are the key ideas that need to be solved for this project to be completed. These are elements 

inside the black box shown in the context diagram> 

Key Functionality 

<List or draw the major users and epics> 

Measures 

<What will increase/decrease if we succeed?> 

Stakeholders 

Stakeholder 

Type 

Representative Success Criteria Additional 

Responsibilities 

Sponsors    

End Users    

Partners    

Insiders    

 

Other Scope Considerations 

<Any other thoughts that help the team and outsiders understand the scope of the solution and 

project including things that are out of scope that are asked about frequently.> 

Project Constraints 

Type Constraint Source Rationale 

Schedule    

Budget    

Resources    

Technology    

Compliance    

Conformance    

Quality    

 

4. Click Done:  
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5. Click SAFe Artifact Templates in the breadcrumb trail at the top of your artifact to return to that 

folder:  

 

 

SOLUTION INTENT TEMPLATE 
1. Select the drop-down arrow to create a new [SAFe] Solution Intent artifact template:  

 

Note: If you do not see the artifact type in the list, you need to click More… and then specify the 

type in the Create Artifact dialog box: 

 

2. Specify these details:  

Name: [SAFe] Solution Intent Template 

Template: None 

Open artifact: <checked> 
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3. Copy and paste the following text into your new artifact:  

[Solution Intent Title] 

<Derived from the Value Stream Epic for the solution being described.> 

Vision 

<What is the vision for this specific solution?> 

Specifications 

<Describe specifications, link to Solution Context for details.> 

Architecture 

<Describe the critical architectural elements of the solution, if applicable.> 

Design 

<Describe the use cases and other design elements relevant at this level. Also describe any solution 

trade-offs that should be vetted with stakeholders and customers.> 

Tests 

<List the set of tests that must be performed in order to meet the Criteria for Success (provided by 

the associated Value Stream Epic for this Solution).> 

 

4. Click Done:  
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5. Click SAFe Artifact Templates in the breadcrumb trail at the top of your artifact to return to that 

folder:  

 

SOLUTION CONTEXT TEMPLATE 
1. Select the drop-down arrow to create a new [SAFe] Solution Context artifact:  

 

Note: If you do not see the artifact type in the list, you need to click More… and then specify the 

type in the Create Artifact dialog box: 

 

2. Specify these details:  

Name: [SAFe] Solution Context Template 

Template: None 

Open artifact: <checked> 
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3. Copy and paste the following text into your new artifact:  

[Solution Context Title] 

<Mapped to the Solution Intent title that is informed by this context.> 

Installation  

<Identify any installation considerations and constraints.> 

Operating Environment 

<Describe the operating environment, highlighting any distinctions for this solution above and 

beyond the Value Stream operating environment.> 

Packaging 

<Describe how the solution will be packaged, highlighting unique considerations.> 

Support 

<How will the solution be supported? List specific resources charged with ensuring that Support 

collateral is developed along with the solution. > 

Enablement 

<How will sellers and customers be enabled on the solution? List specific resources charged with 

ensuring that Enablement collateral is developed along with the solution. > 

Services 

<Will there be services associated with, or even packaged with, the solution? List specific resources 

charged with ensuring that Services collateral is developed along with the solution. > 

Marketing 
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<How will the solution be marketed so that it is easily discoverable by customers? List specific 

resources charged with ensuring that Marketing collateral is developed along with the solution. 

Specifically describe the digital “try, buy, sell” plan.> 

Selling 

<How will the solution be sold? List specific resources charged with actually selling or developing the  

Sales collateral associated with the solution. > 

 

4. Click Done:  

 

5. Click SAFe Artifact Templates in the breadcrumb trail at the top of your artifact to return to that 

folder:  

 

 

LIFECYCLE SCENARIO TEMPLATE 
1. Select the drop-down arrow to create a new [SAFe] Lifecycle Scenario artifact template:  

 

Note: If you do not see the artifact type in the list, you need to click More… and then specify the 

type in the Create Artifact dialog box: 
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2. Specify these details:  

Name: [SAFe] Lifecycle Scenario Template 

Template: None 

Open artifact: <checked> 

 

3. Copy and paste the following text into your new artifact:  

[Lifecycle Scenario Title] 

A <role/team> does <something> to <purpose> 

Example: A Team Adopts DevOps to Reduce Time to Market 

Purpose 

<Describe briefly the activities that comprise the scenario.> 

Example:  

1. Optimize speed of delivery 

2. Prepare for the first iteration (Program Increment) 
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Demonstrated Value 

<List the value of the solution demonstrated by the lifecycle scenario.> 

Roles 

<List the roles involved in the lifecycle scenario.> 

Acts 

<Link and embed the Scenario Acts (as children).> 

 

4. Click Done:  

 

5. Click SAFe Artifact Templates in the breadcrumb trail at the top of your artifact to return to that 

folder:  

 

 

SCENARIO ACT TEMPLATE 
1. Select the drop-down arrow to create a new [SAFe] Scenario Act artifact:  

 

Note: If you do not see the artifact type in the list, you need to click More… and then specify the 

type in the Create Artifact dialog box: 
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2. Specify these details:  

Name: [SAFe] Scenario Act Template 

Template: None 

Open artifact: <checked> 

 

3. Copy and paste the following text into your new artifact:  

[Scenario Act Title] 

<Title of the activity> 

Example: Align & Balance Program Backlogs 

Description 

<High-level description.> 

Example: In this Act, the Portfolio and Program Teams collaborate to align the Program work for the 

next few Program Increments with the Portfolio priorities. As this happens, the Portfolio will be 

watching for any risks or impediments so that mitigation happens in near real time. This Act involves 
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both Portfolio and Program project areas, so roles change for the Program Leads depending on 

which project area is used. 

 

Roles 

<List the roles involved in the scenario act.> 

Input 

<Describe any inputs into this activity.> 

Output  

<Describe any outputs as a result of performing this activity.> 

Scenes 

<Link and embed the Scenario Scenes (as children).> 

 

4. Click Done:  

 

5. Click SAFe Artifact Templates in the breadcrumb trail at the top of your artifact to return to that 

folder:  

 

 

SCENARIO SCENE TEMPLATE 
1. Select the drop-down arrow to create a new [SAFe] Scenario Scene artifact template:  
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Note: If you do not see the artifact type in the list, you need to click More… and then specify the 

type in the Create Artifact dialog box: 

 

2. Specify these details:  

Name: [SAFe] Scenario Scene Template 

Template: None 

Open artifact: <checked> 

 

3. Copy and paste the following text into your new artifact:  

[Scenario Scene Title] 

<Title of the activity> 

Example: Prepare for Release Planning 

Narrative 

<Provide the scene narrative as a series of steps performed by one or more roles.> 
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4. Click Done:  

 

5. Click SAFe Artifact Templates in the breadcrumb trail at the top of your artifact to return to that 

folder:  

 

Now that all of your [SAFe] xxx Templates have been created, save them as Artifact Templates.  

PERSIST ARTIFACT TEMPLATES 
In this section, you will create persistent artifact templates for all of the templates you created in the 

previous section. Upon completion, you will have these Artifact Templates:  

 

1. Select Manage Project Properties from the Administration drop-down menu:  

 

2. Click Templates on the menu bar, then Artifact Templates in the Templates pane: 
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3. For each [SAFe] xxx Template you created, create a new Artifact Template:  

a. Click + New Template… :  

b. Specify these details:  

Template name: [SAFe] Value Stream Template 

Description: Template used to create a [SAFe] Value Stream 
artifact.  

Create template based on: <Browse to SAFe Artifact Templates  and select Template 

artifact> 

 

c. Click Create.  

d. Repeat the steps above for the following templates: 

Template name: [SAFe] Program Template 

Description: Template used to create a [SAFe] Program artifact.  

 

Template name: [SAFe] Vision Template 

Description: Template used to create a [SAFe] Vision artifact.  
 

Template name: [SAFe] Solution Intent Template 

Description: Template used to create a [SAFe] Solution Intent 
artifact.  
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Template name: [SAFe] Solution Context Template 

Description: Template used to create a [SAFe] Solution Context 
artifact.  

 

Template name: [SAFe] Lifecycle Scenario Template 

Description: Template used to create a [SAFe] Lifecycle Scenario 
artifact. 

 

Template name: [SAFe] Scenario Act Template 

Description: Template used to create a [SAFe] Scenario Act 
artifact.  

 

Template name: [SAFe] Scenario Scene Template 

Description: Template used to create a [SAFe] Scenario Scene 
artifact.  

 

CREATE THE SAFE 4.0 PORTFOLIO PROJECT TEMPLATE  
You now have a Rational DOORS Next Generation project area configured to support SAFe V4.0 and can 

create a new project template.  

1. Select Manage Project Properties from the Administration drop-down menu:  

 

2. Click Templates on the menu bar, then Project Templates in the Templates pane. Select + New 

Template… to add a new project template:  

 

3. In the Create Template dialog, specify these details:  

Base Project: My SAFe V4.0 Portfolio 

Name: SAFe V4.0 Portfolio Project Template 

Description: Use this template to create a Rational DOORS Next 
Generation project area supporting SAFe V4.0. 

Include: <All except Module Templates and Links between Artifacts> 
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4. Click OK and then Finish when the process is complete:  

 

 
You should see your new template is in the list of Project Templates:  
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5. Select the Action menu and then Download:  

 

 
6. Save the file to a local directory. To use this project template in another RDNG instance, you simply 

go to this same Templates browser page in the new environment and select Upload Template… : 

 

 
 

Congratulations! You have completed the SAFe V4.0 configuration for Rational DOORS Next Generation.  

RATIONAL QUALITY MANAGER TEMPLATE CONFIGURATION 

CONFIGURE RQM PROCESS TEMPLATE (BROWSER) 
1. Launch RQM’s Administration Page in your browser and log on as an Administrator.  

2. Navigate to the Templates page by selecting the Template option from the menu bar.  

Ensure you have the SAFe predefined templates deployed. If you do not see these process 

templates, click the Deploy Predefined Templates link.  
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3. Select Project Areas > Create > Project Area from the menu bar and create a new SAFe V4.0 Quality 

Management Portfolio project area based on the existing Quality Management for SAFe 3.0 

template:  

 

4. Add the Administrator user as a member of the project with the Test Team Member role. 

Update the project area characteristics as described in the sections below.  
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TIMELINES 
Update the Timeline hierarchy to include the Value Stream level.  

1. Select the Timelines option in the left navigation bar.  

2. Create a Value Stream (Cadence) iteration at the top level of the timeline by clicking on the Create 

Iterations… button on the right. 

3. Name the iteration Value Stream 1 (rename) Cadence and clear the Start Date by clicking in 

the field and using the delete or backspace key. Click OK. 

 
4. Drag and drop the Program 1 (rename) and Program 2 (rename) iterations on top of the Value 

Stream 1 (rename) Cadence iteration so they are children of the Value Stream iteration. 

 
5. Save the project area by clicking the Save button in the upper right corner. 

 

ARTIFACT CATEGORIES 
Add the Value Stream option to SAFe Level and make Program a multivalued option. 

1. Open the project area dashboard by clicking on the Explore Project button.  

2. Select Manage Project Properties on the Admin menu. 

 
3. Expand Artifact Categories on the left and click on Test Plan Categories. 

4. Add a new value to SAFe Level by clicking on Create Value on the Action menu. 
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5. Name the value SAFe Value Stream and click OK. 

 
6. Set the Program category to allow multiple selections by clicking on Define as Multivalued on the 

Action menu. 

 
7. Save your changes. 

 

RELATED SITES 
Update the IBM’s Support for SAFe link. 

1. On the Manage Project Properties screen, expand Properties on the left and click on Related Sites. 

2. Change the URL value for IBM’s Support for SAFe to: http://ibm.biz/safesupport 
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3. Save your changes. 

 

ARTIFACT TEMPLATES 
Create a Value Stream Test Plan template. 

1. Select Manage Artifact Templates on the Admin menu. 

 
2. Group by Type and select Show All to see all the available templates. 

 
3. Select the SAFe Team Test Plan Template and click Copy Template on the Action menu. 

 
4. Set the following fields to create the Value Stream Test Plan Template and click OK: 

a. Name: SAFe Value Stream Test Plan Template 

b. Description: Test Plan template for scaled agile value stream test 
efforts 

c. ID: com.ibm.rqm.planning.templates.testplan.template_safevaluestream 
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DASHBOARD  
Add a Value Stream tab to the project dashboard. 

1. Navigate to the project area dashboard and click on the Program 1 (rename) tab. 

2. Click the tab down arrow and select Duplicate Tab. 
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3. See that there are now two Program 1 (rename) tabs. Rename the one on the left to Value 

Stream 1 (rename) and save your changes. 

 

 

CONFIGURE RQM PROCESS TEMPLATE (ECLIPSE) 
The next set of changes must be performed in the Eclipse client.  

1. Launch the Rational Team Concert Eclipse client and establish a Repository Connection to RQM.  

2. Right-click on the Repository Connection, choose Managed Connected Project Areas and select your 

Portfolio Quality Management project area.  

EXTRACT PROCESS TEMPLATE 
You are now ready to extract the process template you’ve configured in your Portfolio Quality 

Management project area.  

1. Right-click on your Portfolio Quality Management project area and select Extract Process 

Template… 

2. Enter the following information: 

a. Name: My SAFe V4.0 Quality Management Process 

b. Process ID: safe40.quality.process 

c. Summary: Customized process template for SAFe V4.0 Quality Management 
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3. Click Finish. The new Process Template is opened for editing.  

DASHBOARD TEMPLATE 
In this section, you create the Value Stream dashboard template and viewlets so that they are pre-

populated when creating a new Portfolio Quality Management project area from your new process 

template. 

1. Click the Process Configuration tab and navigate to Project Configuration > Configuration Data > 

Dashboards > Dashboard Templates. 

 
2. In the Dashboard Templates area on the right, right-click on ${scope} Project Dashboard (project) 

and select Add page. 
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3. Title the page Value Stream 1 (rename) and move it up to just after the Portfolio page using 

the Up button. 

 

4. Right-click on the Value Stream 1 (rename) (page) and select Add column.  

 

5. Repeat the previous step so you have three columns. 
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6. Expand the Program 1 (rename) (page) and duplicate the viewlets that are on the Program 1 

(rename) page by performing the following steps for each viewlet: 

 
a. Add a viewlet to the appropriate Value Stream 1 (rename) (page) column by right-clicking 

on the column and selecting Add viewlet. 

 
b. Click on the corresponding Program 1 (rename) viewlet and copy and paste the following 

information to the new Value Stream 1 (rename) viewlet: 

1. General tab: Identifier 

2. General tab: Title (when populated on Program 1 (rename) viewlet) 

3. Preferences tab: Report Template (when populated on Program 1 (rename) viewlet) 

4. Preferences tab: Report (when populated on Program 1 (rename) viewlet) 

 

 
c. Repeat steps a – b above for all five viewlets to duplicate the Program 1 (rename) viewlets 

on the Value Stream 1 (rename) page. 
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d. Save your changes. 

RELATED SITES 
In this section, you update the IBM’s Support for SAFe link so that it is correct when creating a new 

Portfolio Quality Management project area from your new process template. 

1. Click the Process Configuration Source tab. 

 
2. Search for RQM_RELATED_LINKS. 

 
3. On the IBM’s Support for SAFe line, change the url to “http://ibm.biz/safesupport” 

 
4. Save your changes. 

Congratulations! You have completed all the changes to the Quality Management process template for 

SAFe V4.0. 

 

http://ibm.biz/safesupport

